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Tutorial: Data Envelopment Analysis with deaR dR

1. INTRODUCCION.

deaR es un paquete de R (software libre) que permite ejecutar un amplio y variado nimero
de modelos basados en el Andlisis Envolvente de Datos.

Este tutorial estd pensado para que los no usuarios de R puedan utilizar el paquete deaR,
pero no es una manual de introduccion a R*.

Si eres usuario de R puedes ir directamente a las secciones 5y 7.

Queremos que deaR se convierta en el software referente de aquellos investigadores,
profesores, estudiantes y usuarios en general del Andlisis Envolvente de Datos. Por esto,
realmente agradeceremos cualquier comentario y sugerencia para mejorar deaR. También
aceptamos sugerencias de modelos DEA y consideraremos su programaciéon en nuevas
versiones de deaR. En este sentido, nos gustaria anticipar que en una nueva version de deaR
se incluirdn modelos o caracteristicas no cubiertos actualmente como: DEA estocastico,
Network DEA, indices de Malmquist (otras descomposiciones y bootstraping), valores
negativos y extensidon de inputs/outputs no deseables a otros modelos en los que ahora no
estdn disponibles, etc.

En breve lanzaremos la version deaR Shiny (es una aplicacion web interactiva). Os
mantendremos informados cuando la app esté disponible.

2. DESCARGAR E INSTALAR R Y RStudio.

Para poder utilizar deaR el primer paso consiste en descargarnos e instalar R y RStudio.

2.1. Instalacion de R.

Para instalar R en nuestro ordenador, vamos a la pagina web de R project: http://www.r-
project.org (ver Figura 1).

Figura 1. Pagina web de R.

R R TheR Project for Statistical © X +

¢ o @ & https://www.r-project.org L w

R« The R Project for Statistical Computing

Getting Started

R is a free software environment for statistical computing and graphics. It compiles and runs on a wide
variety of UNIX platforms, Windows and MacOS. To download R, please choose your preferred CRAN
mirror.

[Home]

Download
CRAN
If you have questions about R like how fo download and install the software, or what the license terms
R Project are, please read our answers [o frequently asked questions before you send an email

About R

Logo News

Contributors
What's New?
Reporting Bugs
Conferences = You can now support the R Foundation with a renewable subscription as a supporting member
Search

Get Involved: Mailing Lists
Developer Pages » The R Foundation has been awarded the Personality/Organization of the year 2018 award by the
R Blog professional association of German market and social researchers

+ The R Foundation Conference Committee has released a call for proposals to host useR! 2020 in
North America

« R version 3.5.1 (Feather $pray) has been released on 2018-07-02.

Para descargar R, hacemos clic en CRAN y seleccionamos el enlace del “espejo” mas préximo
a nuestra ubicacion.

1 En www.uv.es/vcoll esta disponible un Curso introductorio de R (en espafiol).
https://cran.r-project.org/doc/manuals/r-release/R-intro.pdf (en Inglés).
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Tutorial: Data Envelopment Analysis with deaR dR

Ahora, en funcién del sistema operativo de nuestro ordenador, seleccionamos la opcién
adecuada (ver Figura 2).

Figura 2. Versiones de R.

The Comprehensive R Archive Network

Download and Install R

Precompiled binary distributions of the base system and contributed packages, Windows and Mac users most likely want one of
these versions of R:

* Download R for Linux
» Download R for (Mac) O5 X
* Download R for Windows

R is part of many Linux distributions, you should check with your Linux package management system in addition to the link
above.

a) Instalar R en Windows.

Al hacer clic sobre Download R for Windows iremos a la pagina que se reproduce mas abajo.
Hacemos clic sobre install R for the first time (ver Figura 3).

Figura 3. R para Windows.

Subdirectories:

base Binaries for base distribution. This 15 what you want{p i

coniik Binanes of contnibuted CRAN pac_kag_es (for R>=2.13.% E f#¥es). There is also information on third
—_— party software available for CRAN Windows services and corresponding env and make vanables.

old contrib Binarnies of contnibuted CRAN packages for outdated versions of R (for R < 2.13.x; managed by Uwe Ligges).

Riools Tools to build R and R packages. This is what you want to build your own packages on Windows, or to build R itself

Please do not submit binaries to CRAN. Package developers might want to contact Uwe Ligges directly in case of questions / suggestions related to Windows bimnaries

You may also want to read the R FAQ and R for Windows FAQ.

Leoaded Wi

Note: CRAN does some checks on these binanes for viruses, but cannot give guarantees. Use the normal prec with do exec

En la siguiente ventana, hacemos clic sobre Download R 3.5.1 for Windows y guardamos el
archivo de instalacién (ver Figura 4).

Figura 4. Descargar R para Windows.
R-3.5.1 for Windows (32/64 bit)

mm R 3.5.1 for Windows 2 megabytes. 32/64 bit)

Installa 10Ns
New features in this version

If you want to double-check that the package you have downloaded matches the package distributed by CRAN. you can compare the md3sum of the .exe to the
fingerprint on the master server. You will need a version of md3sum for windows: both graphical and command line versions are available.

Frequently asked questions

® Does R run under my version of Windows?
» How do [ update packages in my previous version of R?
® Should I run 32-bit or 64-bit R?

Please see the R FAQ for general information about R and the R Windows FAQ for Windows-specific information.

Abrimos el archivo descargado (haciendo doble clic sobre fichero) para instalar R.

b) Instalar R en Mac.

Al hacer clic sobre Download R for (Mac) OS X iremos a la pagina que se reproduce mas
abajo. Hacemos clic sobre R-3.5.1.pkg para descargarnos el fichero de instalacion (ver Figura
5).

©Coll-Serrano, V.; Benitez, R. and Bolds, V. (2018)
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Figura 5. R para Mac.

R for Mac OS X

This directory contains binaries for a base distribution and packages to run on Mac OS X (release 10.6 and above). Mac OS 8.6 to 9.2 (and Mac OS X 10.1) are no
longer supported but you can find the last supported release of R for these systems (which 1s R 1.7.1) here. Releases for old Mac OS X systems (through Maec OS X
10.5) and PowerPC Macs can be found in the old directory.

Note: CRAN does not have Mac OS X systems and cannot check these binaries for viruses. Although we take precautions when assembling binaries, please use the
normal precautions with downloaded executables.

As 0f 2016/03/01 package binaries for R versions older than 2.12.0 are only available from the CRAN archive so users of such versions should adjust the CRAN
mirror setting accordingly.

R 3.5.1 "Feather Spray" released on 2018/07/05

Important: since R 3.4.0 release we are now providing binaries for OS X 10.11 (El Capitan) and higher using non-Apple toolkit to provide support for OpenMP
and C++17 standard features. To compile packages you may have to download tools from the tools directory and read the corresponding note below.

Please check the MD3 checksum of the downloaded image to ensure that it has not been tampered with or corrupted during the mirroring process. For example type
md5 R-3.5.1.pkg

in the Terminal application to print the MD5 checksum for the R-3.5.1 pkg image. On Mac OS X 10.7 and later you can also validate the signature using
pkgutil --check-signature R-3.5.1.pkg

Lastest release:

R 3.5.1 binary for OS X 10.11 (El Capitan) and higher. signed package. Contains R 3.5.1 framework.
= e e i R.app GUI 1.70 in 64-bit for Intel Macs. Tcl/'Tk 8.6.6 X11 libraries and Texinfo 5.2. The latter two
(ca. TAMB) D b= components are optional and can be ommitted when choosing "custom install”, they are only needed 1f

vou want to use the celtk R package or build package documentation from sources.

Note: the use of X11 (including tclck) requires XQuartz to be installed since it 1s no longer part of
08 X Always re-mnstall XQuartz when upgrading your macOS to a new major version.

Important: this release uses Clang 6.0.0 and GNU Fortran 6.1. neither of which is supplied by Apple.
If you wish to compile R packages from sources. you will need to download and install those tools -
see the tools directory.

Abrimos R-3.5.1.pkg y seguimos las instrucciones para instalar R.

2.2. Instalar RStudio.

Una vez que hemos instalado R, descargamos RStudio desde el siguiente enlace (ver Figura
6):

https://www.rstudio.com/products/rstudio/download/#download

Figura 6. Descargar RStudio.
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RStudio Desktop 1.1.463 — Release Notes
RStudio requires R 3.0.1+. If you don't already have R, download it here.

Linux users may need to import RStudio's public code-signing key prior to installation, depending on the operating system's security
policy.

Installers for Supported Platforms

Installers Size Date MD5

858MB 2018-10-28 58b3d796dBcf96fbB5B0c62f46abb4dd
7T45MB 2018-10-28 a75032ba4d7daaalcaBda01548278d5%4
893MB 2018-10-28 Bae7S5S5faSfaeZbafce2B89df3358aafe3
974MB  2018-10-28 bc50debd34926clcc3ae4a209d67d649
63 MB 2018-10-29 cfd655dbl18619cc78d1592fefaa7c753

88.1MB  2018-10-28 742f0bad&0dfeaa3281576el4adEe55%e

906MB 2018-10-28 <¢7303067a0ca%9deeca7e427b856352d1

Para descargar el fichero ejecutable, seleccionamos la opcidon segun nuestro sistema
operativo:

e RStudio 1.1.463 - Windows Vista/7/8/10

©Coll-Serrano, V.; Benitez, R. and Bolds, V. (2018)
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e RStudio 1.1.463 - Mac OS X 10.6+ (64-bit)

Primero, guardamos el fichero. A continuacidn, lo abrimos para instalar RStudio. Seguimos
las instrucciones de instalacion.

3. INICIAR RStudio

En general, trabajamos con la interfaz de RStudio antes que con la de R porque la primera es
“mas amigable”.

Para iniciar RStudio, hacemos clic en el icono de RStudio: B

Al abrir RStudio deberiamos ver algo parecido a la Figura 7:

Figura 7. Interfaz de RStudio.

(%] RStudio - gl
File Edit Code View Plots Session Build Debug Profile Took Help

= Envirenment Histoery Connections —
’

a “* Import Dataset = ¥ List =
R version 3.4.2 (2017-09-28) -- "Short Summer"
Copyright (C) 2017 The R Foundation for Statistical Computing
Platform: x86_64-wb4-mingw32/x64 (64-bit)

b Global Environment =

R is free software and comes with ABSOLUTELY NO WARRANTY.
vou are welcome to redistribute it under certain conditions.
Type 'license()' or 'licence()' for distribution details.

R is a collaborative project with many contributors.
Type 'contributors()' for more information and
‘citation()' on how to cite R or R packages in publications.

P|ets Packages Help Viewer —

Type 'demo()' for some demos, 'help()' for on-line help, or

'help.start()' for an HTML browser interface to help. Q) New Folder | @ Delete = Rename = {G More ~
Type 'q()' to quit R. &% Home
A MName Size Modified
I
I richeros y carpetas
= en Mis documentos
.

Por defecto, la consola se encuentra en el panel izquierdo. Primero aparece un texto
informativo y después el prompt del sistema (“>”). éVemos el cursor intermitente? Aqui es
donde R espera que le demos instrucciones. Para ejecutar las instrucciones y obtener el
resultado pulsamos Enter.

3.1. Crear un script.

Trabajar en la Consola es muy limitado ya que en la Consola las instrucciones generalmente
se escriben y ejecutan una por una. Lo habitual es trabajar con scripts o ficheros de
instrucciones. Estos ficheros tienen la extension “.R”.

Para crear un script, seleccionamos File > New File > R Script

Ahora el panel del script se situa en la parte superior-izquierda de RStudio y la Consola en el
panel inferior-izquierdo. Por defecto, el nombre del nuevo script es “Untitled1” (ver Figura
8).

En el script podemos escribir las instrucciones linea por linea. Las instrucciones las podemos
ejecutar una a una; también podemos seleccionar todas (o algunas de) las instrucciones y
ejecutar la seleccién. Para ejecutar una instruccién o seleccién de instrucciones hacemos clic
en = Run

©Coll-Serrano, V.; Benitez, R. and Bolds, V. (2018)
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Figura 8. Script.
)

RStudio -

File Edit Code View Plots Session Build Debug Profile Tools Help

@] Untitled1 Environment History Connections

;
Source on Save A S #Run | % Source ~ 1 #* Import Dataset = | List =

1

™ Global Environment ~

Files Plots Packages Help Viewer

Q] New Folder | © Delete 5| Rename | 4gk More =
&5

il Home

A Name Size Modified

1=% (Top Level) 3 R Script ¢

Console

You are welcome to redistribute it under certain conditions. "
Type "license()' or 'licence()' for distribution details.

Ficheros y carpetas
en Mis documentos
R is a collaborative project with many contributors.

Type 'contributors(Q' for more information and
'citation()' on how to cite R or R packages in publications.

Type 'demo()' for some demos, 'help()' for on-line help, or
'help.start()' for an HTML browser interface to help.
Type 'q()' to quit R.

>

4. Como crear y trabajar con proyectos en RStudio

Una vez hemos arrancado RStudio, deberiamos establecer el directorio de trabajo para
indicar a R y RStudio donde se encuentran nuestros datos, scripts, etc. Sin embargo, en
nuestra opinién, la mejor opcidn es crear un proyecto. Al crear un proyecto todos los
ficheros (de datos, scripts, etc.) y directorios quedan vinculados directamente al proyecto. Es
decir, todo el trabajo que realicemos en un proyecto estara auto-contenido en el directorio
del proyecto. De esta forma, facilmente podemos compartir nuestro proyecto con alguien
mas o podemos copiar y pegar nuestro proyecto en otro ordenador, etc.

Nota importante:

Creamos un proyecto para cada actividad/trabajo (por ejemplo, para
cada articulo/paper).

Para organizar correctamente un proyecto, recomendamos crear un
directorio especifico para los datos, resultados, documentos de texto,
etc.

4.1. Crear un proyecto.

Para crear un proyecto en RStudio, seleccionamos File > New project... Se abrira una ventana
similar a la que se muestra en la siguiente Figura.

©Coll-Serrano, V.; Benitez, R. and Bolds, V. (2018)
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Figura 9. Crear proyecto en RStudio.

New Project

Create Project

1 New Directory
L

Start a project in a brand new working directory

Existing Directory
L= R- Associate a project with an existing working director

s Version Control
Checkout a project from a version control repositor

Cancel

Para crear un proyecto en un nuevo directorio, hacemos clic en el botén New Directory.
Seguidamente, seleccionamos el tipo de proyecto, en nuestro caso New Project. Ahora,
asignamos un nombre al directorio (carpeta) que se va a crear y que al mismo tiempo sera el
nombre del proyecto de R. Para terminar, hacemos clic en el botdn Create Project. Al seguir
este proceso se habrd creado una carpeta en Documentos y dentro encontraremos el
archivo: “nombre_carpeta.Rproj”.

Para crear un proyecto en una carpeta que ya existe, hacemos clic en el botdén Existing
Directory y después seleccionamos el directorio o carpeta ayuddndonos del botén Browse....
Una vez elegida la carpeta, clicamos en el botdn Create Project.

4.2. Abrir un proyecto.

Para abrir un proyecto, hacemos doble clic sobre el archivo con extension “.Rproj’. También
podemos abrir el proyecto desde el menu de RStudio: File > Open Project...

Ventaja de los proyectos: cualquier fichero que guardemos trabajando en un proyecto se
guardara en la carpeta del proyecto.

4.3. Informacion adicional.

Aqui os dejamos la direccion de dos lecturas cortas sobre los proyectos, la segunda incluye
informacién sobre cdmo crear proyectos.

e https://www.r-bloggers.com/managing-projects-using-rstudio/

e https://www.ssc.wisc.edu/sscc/pubs/RFR/RFR Projects.html#projects

4.4. Como crear un proyecto.

Paso 1. Abrir RStudio

Paso 2. Seleccionar File > New Project

Paso 3. Seleccionar New Directory

Paso 4. Project Type: seleccionar New Project

Paso 5. Directory name: Paper_1

Paso 6: Create project as subdirectory of: seleccionar con el browse la ruta donde se
creara el proyecto. Por ejemplo, seleccionar el escritorio.

©Coll-Serrano, V.; Benitez, R. and Bolds, V. (2018)
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Paso 7. Hace clic sobre Create Project.

dR

Resultado: En el escritorio se habra creado una carpeta con el nombre “Paper_1". Dentro de

esta carpeta habra dos ficheros (ver Figura 10):
= Paper_1 (type: R Project)
= _Rhistoy (type: RHISTOY file)

Figura 10. Proyecto “Paper_1".
©

File Edt Code View Plots Session Build Debug Profile Tools Help
9 | Untitled1 = Environment History Connections

,
Source on Save A ) * Run - f ** import Dataset « "
% Giobal Environment =

Plots Packages Help Viewer
Q. NewFolder @ Delete = Rename g More -

Vicente

»

0B
218 B

Console cent
You are welcome to redistribute it under certain conditions. =
Type 'license(Q' or 'licence()' for distribution details.

R is a collaborative project with many contributors.
Type 'contributors()' for more information and
‘citation()" on how to cite R or R packages in publications.

Type 'demo()' for some demos, 'help()' for on-line help, or
'help.start()' for an HTML browser interface to help.

Type 'q()' to quit R.

>

Nov 1, 2018, 8:19 Al
Nov 1, 2018, 8:20 Al

Nota importante:
La sesidon de trabajo con un proyecto se abrira siempre

haciendo doble clic sobre el fichero R Project

o
File > Open Project y seleccionando el proyecto

Se recomienda no trabajar simultdneamente con varios proyectos.

5. Instalar y cargar deaR

Abrir RStudio o el proyecto “Paper_1”.

Seleccionar File > New File > R script

5.1. Instalar deaR.

Para instalar deaR, escribir en el script:
install.packages(“deaR”)

y ejecutar la instruccion: hacer clic en el botén Run: ~#Rrun (ver Figura 11).

En la pestafia Packages situada en la ventana inferior derecha de RStudio, aparece el listado
de todos los paquetes que el usuario tiene instalados en R. Ahora deberia aparecer deaR.

©Coll-Serrano, V.; Benitez, R. and Bolds, V. (2018)
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Nota importante:

Solo hay que instalar deaR una vez. Las nuevas
versiones de deaR las podemos obtener
actualizando el paquete.

Figura 11. Instalar deaR.

dR

(%) C:/Users/Vicente/Desktop/Paper_1 - RStudio - g -_
File Edit Code View Plots Session Build Debug Profile Tools Help
@ | Untitled1* - Environment History Connections -
| Sourceonsave | O 7 - ik, 4 Source ~ 2 [ | 7% import Dataset ~ | & List =
1 install.packages("deaR") T} Global Environment =
onment is e
Files Plots Help  Viewer P |
&l instal | @ pazte | Wl Packrat
Name Description Version
— T————————————————————= =
csvy Import and Export CSV Data with a YAML  0.3.0
1:24 (Top Level) = R Script = Metadata Header
curl A Modern and Flexible Web Client forR 3.2
Conscle C:/Users/Vicente/Desktop/Paper_1/ = L s z
- - = - — data.table Extension of ‘data.frame’ 1.116
You are welcome to redistribute it under certain conditions. A o R Dabaa i 100
Type 'Ticense()' or 'licence()' for distribution details. atabaseiriterace o
dbplyr A 'dplyr* Back End for Databases 1.2.2
R is a C(Jﬂe_lbur'ati ve project wi Fh many (_ontr'i butors. deaR Conventional and Fuzzy Data 10
Type 'gontr'wlbutolr;s Q' for more 1nfor'maE on and b1 . Envelopment Analysis
citation()' on how to cite R or R packages in publications. e Debug R Packages 70
Type 'demo()' for some demos, 'help()' for on-Tline help, or DEoptimR Differential Evolution Optimization in 1.0-8
‘help.start()' for an HTML browser interface to help. Pure R
Type 'g()' to quit R. desc Manipulate DESCRIPTION Files 120
devtools Tools to Make Developing R Packages 1136
- W Easier v

5.2. Cargar deaR.

Una vez instalado deaR, o cualquier otro paquete de R, para usarlo primero hay que cargarlo

(ver Figura 12). Para ello, escribimos en el script:
library(“deaR”)

y ejecutamos la instruccion haciendo clic en el botdn Run: ~= grun

Nota importante:

Es necesario cargar deaR en cada sesion de trabajo.

©Coll-Serrano, V.; Benitez, R. and Bolds, V. (2018)
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Figura 12. Cargar deaR.
5]

File Edit Code View Plots
@] untitled1*

Source on Save A S
install.packages("deaR"

:
2
3 Tlibrary("deaR")
4

41 (Top Level) 3

Console C:/Users

C:fUsers/Vicente/Desktop/Paper_1 - RStudio

Session Build Debug Profile Tools Help

= —=

R Script 3

The following objects are masked from ‘package:stats’:

filter, lag

The following objects are masked from ‘package:base’:

intersect, setdiff, setequal, union

warning message:

package ‘dplyr’ was built under R version 3.4.4

>

~

Environment  History

) Global Environment ~

Connections

;
“* Import Dataset = ']

Files le Help  Viewer

@ update

£ Install

Name
csvy

curl
datatable
DBI

dholvr

debugme
DEoptimR

desc
devtools

B Pacrat

Descriptic

Import and Export CSV Data with a YAML  0.3.0

Metadata Header

A Modern and Flexible Web Client for R
Extension of ‘dataframe’

R Database Interface

A dplyr Back End for Databases
Conventional and Fuzzy Data
Envelopment Analysis

Debug R Packages

Differential Evolution Optimization in
Pure R

Manipulate DESCRIPTION Files

Tools to Make Developing R Packages
Easier

List =

32
1116
100
122
10

110
1.0-8

120
1136

6. Guardar el script y cerrar la sesion de trabajo.

Para guardar el script, seleccionamos File > Save as...

Ahora, nombramos el fichero (por ejemplo: sesion_1) y hacemos clic en el botén Save. Por
defecto el script se guardara en el proyecto de trabajo (“Paper_1”). Esta es una ventaja de

trabajar con proyectos.

Observad que ahora el nombre del documento R (script) ha cambiado de “Untitled1” a
“sesion_1.R” (ver Figura 13). Este fichero también aparece en el listado de ficheros que
forman parte del proyecto “Paper_1”.

Nota: Hasta ahora, el contenido de este primer documento/script de R es irrelevante. Lo que
es importante recordar es que en un script podemos guardar todas las instrucciones.

Nota importante:

Asignar nombres a los scripts que sean ilustrativos de su contenido.

©Coll-Serrano, V.; Benitez, R. and Bolds, V. (2018)



Tutorial: Data Envelopment Analysis with deaR dR

Figura 13. Guardar script.

(%) C:/Users/Vicente/Desktop/Paper_1 - RStudio - g n_
File Edit Code View Plots Session Build Debug Profile Tools Help
— Environment  History  Connections -]
Source on Save A S - *Run | "% Source ~ “ “* Import Dataset = ' List =

install.packages ("dear™) "} Global Environment =

1
2
3 Tlibrary("deaR")
4
5

Plnts Packages Help Viewer =
G New Folder | © Delete = Rename | g More ~

C: » Users » Vicente ~ Desktop ° Paper_1
4 Name Size Modified
5:1 (Top Level) 3 R Script 3 t

F f— * ] .Rhistory 168 Nov 1, 2018, 11:05/
Console C:/Users/Vicente/Desktop/Pap _

e . . == 2 P 1.Rproj 188 Nov 1, 2018, 11z
You are welcome to redistribute it under certain conditions. .y el el Bl o2 234
Type 'license()' or 'licence()' for distribution details. 47 B Nov 1, 2018, 11:26 4
R is a collaborative project with many contributors.

Type 'contributors()' for more information and
'citation()' on how to cite R or R packages in publications.

Type 'demo()' for some demos, 'help()' for on-line help, or
'help.start()' for an HTML browser interface to help.
Type 'qQ' to quit R.

>

Si queremos cerrar el proyecto, pero permanecer en Rstudio: File > Close project
Si queremos cerrar el proyecto y salir de Rstudio: File > Quit Session

En este punto, vamos a guardar “sesion_1.R”, cerrar el proyecto “Paper_1" y salir de
RStudio.

7. Andlisis envolvente de datos con deaR.

Comenzamos abriendo el proyecto “Paper_1”. Para ello, hacer doble clic sobre el fichero
“Paper_1.Rproj”’. Se abrird RStudio y el proyecto. Recuerda que también puedes abrir
primero RStudio y después el proyecto (File > Open Project).

A continuacion, creamos un nuevo script (File > New File > R Script). En este script escribimos
la instruccién para cargar deaR:

library(“deaR”)
(Nota: Ejecutamos la instruccidén con = gun ).

En el siguiente diagrama de flujo (ver Figura 14) podemos ver los pasos a seguir para realizar
cualquier analisis DEA (Data Envelopment Analysis; en espafiol, Analisis Envolvente de Datos)
con deaR.

10
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Tutorial: Data Envelopment Analysis with deaR

Figura 14. Pasos para utilizar deaR.

First steps:

dR

Step 1

Select dataset

Own data No
set?

Yes

Yes

Time
series?

| Read malmequist |

Step 2

I Read data | I Read Fuzzy data |

| |

Step 3

!

| Select DEA model |

7.1. Importar datos en RStudio.

El primer paso consiste en cargar (importar) los datos que vamos a utilizar para analizar la
eficiencia utilizando el andlisis envolvente de datos. El usuario no familiarizado con R puede
utilizar la opcion Import dataset, es muy sencilla de utilizar. Vamos a verlo con el Ejemplo 1.

m Cargar en R datos de un fichero Excel:

1. Descarga los datos del ejemplo desde www.uv.es/vcoll/Coll Blasco 2006.xlsx y
guarda el fichero en la carpeta del proyecto “Paper_1”.

2. Del menu Environment situado en el panel superior izquierdo, seleccionamos la
opcion: Import Dataset < From Excel (ver Figura 15).

Figura 15. Importar datos de Excel.

o

Fie Edt Code View Plots Session Build Debug Profile Tools Help
') Untitled1*
Source on Save L /-
1 library(dear
2

Console

The following objects are masked from ‘package:stats’:

filter, lag

C:/Users/Vicente/Desktop/Paper_1 - RStudio

— History

T Giobal

* Run b Source =

From Text (base)...
From Text (readr)...
From SPSS..
From SAS..
From Stata.

Files Plots Packages Help Viewer

Q. New Folder | @ Delete = Rename = g More ~
G > Users 7 Vicete > Desitop > Paper.t
A Name
R Saript 2 t
- “ ] Rhistory 168
= & Paper_1.Rproj 2188

@) sesion 1R 478
Coll_Blasco_2006.xsx 84KB

The following objects are masked from ‘package:base’:

intersect, setdiff, setequal, union

warning message:
package ‘dplyr’
>

was built under R version 3.4.4

List =

Modified

Nov 2, 2018, 9:44 Al
Nov 2, 2018, 9:56 Al
Nov 1, 2018, 11:264
Oct 14, 2018, 2202 P

©Coll-Serrano, V.;
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Tutorial: Data Envelopment Analysis with deaR dR

3. Se abre la ventana Import Excel Data. Hacemos clic sobre el boton Browse para
elegir el fichero Excel (“Coll_Blasco_2006.xIsx”)? y clicamos sobre Open (ver Figura
16).

Figura 16. Importar “Coll_Blasco_2006.xIsx”.

[E] C:/Users/Vicente/Desktop/Paper_1 - RStudio - o
File Edit Code View Plots Session Build Debug Profile Tools Help

@ | Untitled1* P History ~ C =0
= ’
- List ~
1 Jipr mport Bl Data
2 )
File/Url:
Data Preview:
(2] Choose File [ ~ |
+ + Paper 1 vl & P
Organizar v Nueva carpeta =y A ® f—
¥ Favoritos “  Nombre T
Auth¢
18 Descargas Rprojuser 0 (2 3
B Esciit ; a2l E
14 F o —
21 (Tog| 2 R
G le C:/U A | 2,2018, 9:44 Al
e | Import Options: e O % 2018, 9:56 Al
& Grupo en el hogar | — 3
The follow & ], 2018, 11:26/
Name: | dataset [} 9 uLL)
o & £ste cquipo g 4,2018, 202 P
ilten 10
Sheet  Default = 3 i Descorges
Documentos
The follow Range: » I Escritorio
. £l Imaaenes X I 2
inters
Nombre: | Coll_Blasco_2006 v
warning meg ?' Reading Excel files using readxl et Cancel
package ‘d L
5 =

<

4. Ahora podemos ver una previsualizacién de los datos “Coll_Blasco _2006.xIsx” y las
opciones de importacién que se han utilizado. En la parte inferior izquierda de esta
ventana se muestra el cddigo R utilizado por Import Excel Data (ver Figura 17). Como
estd seleccionada la opcidn Open Data Viewer?, se abrird el fichero de datos cuando
terminemos de importarlos. Para ello, hacemos clic en Import.

Figura 17. Previsualizacidén datos importados.
L] C:/Users/Vicente/Desktop/Paper_1 - RStudio - o El

File Edt Code View Plots Session Build Debug Profile Tock Help

Q'] Untitled1* = i History € —{=|
| X = = . L List =
1 Tibrd 'meort Bxcel Data
2 .
File/Urtk:
& C/Users/Vicente/Desktop/Paper_1/Coll_Blasco_2006.dsx Browse...
Data Preview:
Authorized_dealer Employees Capital Vehicles Orders
A ] & 14 20 =
B 1 15 25 42 =0
c 14 12 8 30
o] 2 3 25 B
F 1 R an -. -1 et
& of | Previewing first 50 entries.

? 12018, 944 Al
Console /U 1
e Import Options: ode Preview: 0O 3 2018, 9:56 Al

“he Folia - Tibrary(readx1) |, 2018, 11:264
g " | Name | Coll Blasco_2006 Max Rows: 4, 2018, 202 P
Filtep Sheet  Default - skip 0 I 7 Open Data Viewer | Mew(C

The follow

Range: NA:
inters

wWarning me |7 Reading Excel files using readx
package ‘d

2 Coll-Serrano, V.; Blasco-Blasco, O. (2006). Evaluacién de la Eficiencia mediante el Analisis Envolvente de
Datos. Introduccién a los Modelos Basicos. www.eumed.net/libros/2006c/197/
3 Corresponde al cddigo R: View(Coll_Blasco_2006)
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Tutorial: Data Envelopment Analysis with deaR dR

5. Al hacer clic en Import hemos regresado a la ventana principal del proyecto
“Paper_1"”. En una nueva hoja aparecen los datos importados (tiene el mismo
nombre que el dataset) (ver Figura 18). Ademas, en el menu Environment (situado en
el panel superior derecho) se listan los objetos* que vamos creando en R. Ahora
mismo tenemos sélo un objeto: “Coll Blasco_2006". De hecho, este objeto es un
dataframe que contiene 6 observaciones de 5 variables.

Figura 18. Proyecto “Paper_1".
(%] C:/Users/Vicente/Desktop/Paper_1 - RStudio - o Bl

File Edit Code View Plots Session Build Debug Profile Tooks Help
= OHH‘“ = : =3

Filter { ~* Import Dataset = y List =

Coll_Blasco_2006

“ Authorized dealer Employees Capital Vehicles Orders T Global Environment =

1A 8 8 14 20 Data

28 e 15 25 .2 I Coll_Blasco_2.. 6 obs. of § variablesl
3 C 4 8 0

40D 2 13 25 8

5 E 11 8 40 22

6 F 8 0 24 30

Files Plots Packages Help Viewer -

Q. New Folder © Delete = Rename | ¥ More -
C: > Users » Vicente = Desktop ~ Paper_1
A Name
Showing 1 to 6 of 6 entries L
— ] Rhistory 168 Nov 2, 2018, 9:44 Al
Console t r =
L} er_1. 1 ¢ , 9
The following objects are masked from ‘package:base’: & Papes 1 Rpeo) £ Nov 220103500
@] sesion_1.R 478 Nov 1,2018,11:26
intersect, setdiff, setequal, union | Coll_Blasco_2006.xlsx 84 KB Oct 14, 2018, 2:02 P

warning message:
. "t R version 3.4.4

> library(readx1)
l'\d?'ll\'”fl message:
package ‘readx1’ was built under R version 3.4.4

> Coll_Blasco_2006 <- read_excel("Col1_Blasco_2006.x1sx")
> View(Coll_Blasco_2006)

En la Consola podemos ver el codigo utilizado para importar los datos (ver Figura 18):

e library(readxl) = carga el paquete readxl

e Coll_Blasco_2006 <- read_excel(“Coll_Blasco_2006.xlsx”) - la funcién
read_excel() (del paquete readxl) lee el fichero de datos y asigna (<- ) los
datos al objeto “Coll_Blasco _2006".

Muy importante:

Terminologia R: A <- B Esto significa que B (lo que sea B; un dataset, el
resultado de una operacién matematica, una funcion, etc.) es asignado (<-) al
objeto A.

e View(Coll_Blasco_2006) - visualiza (View) el objeto “Coll_Blasco_2006".

6. Copiamos el cédigo anterior en el script “Untitled1” y lo guardamos con el nombre
“sesion_2".

Nuestro proyecto deberia parecerse a la Figura que se encuentra mas abajo (Figura
19).

4Todo en R es un objeto. Un objeto puede ser un dataset, una funcidn, una instruccién, una matriz, etc.
13
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Tutorial: Data Envelopment Analysis with deaR dR

Figura 19. Guardar script de importar datos.
[£] C;/Users/Vicente/Desktop/Paper_1 - RStudio - a “_
File Edit Code View Plots Session Build Debug Profile Tools Help

R = — o

Source on Save A /S~ * Run o= Source ~ il S | #* Import Dataset = "4 List =
é Tibrary(deaR T Global Environment ~
3 library(readx1) Data
4 Col1_Blasco_2006 <- read_excel("Coll_Blasco_2006.x1sx" coll_Blasco_2. 6 obs. of 5 variables
5
Files Plots Packages Help Viewer =
Q7 MewFolder | © Delete =+ Rename = gk More -
€ Users * Vicente * Deskiop * Paper_1 R
A Name Size Modified
5:1 (Top Level) & R Script & t.
2] , 2018, 9:44
TR e ey s =0 - Rhistory 168 Nov 2, 2018, 9:44 Al
: 2 p, 1 j 1 18, 9:56 Al
The following objects are masked from ‘package:base’: o aper_1.Rproj 2188 Noy:2:2018,956
@7 sesion_1.R 478 Nov 1,2018, 11:26 4

intersect, setdiff, setequal, union Coll Blasco_2006.xsx 84K8 Oct 14,2018, 202 P
Mg EesagE 898 Nov 2, 2018, 11:06
package ‘dplyr' was built under R version 3.4.4
> Tibrary(readx1)
warning message:
package ‘readx1' was built under R version 3.4.4
> Coll_Blasco_2006 <- read_excel("Coll_Blasco_2006.x1sx")
> View(Coll_Blasco_2006)

>

En posteriores sesiones ya no sera necesario realizar los pasos 1 a 5 porque tenemos
el cddigo en el fichero “sesion_2.R”. Para importar nuevamente los datos de
“Coll_Blasco _2006.xIsx” sélo tendremos que ejecutar el cddigo de “sesion_2.R”.

deaR también dispone de un importante nimero de datasets. Estos datos proceden de
articulos ya publicados y son utilizados para replicar los resultados de los articulos.
Pensamos que esto es un valor afiadido que ofrece deaR a los investigadores y usuarios de
DEA porque es una ayuda importante para los procesos de ensefianza-aprendizaje de la
metodologia DEA. Podemos consultar la estructura y fuente de los datos haciendo uso de la
ayuda de deaR®.

Veamos como cargar un dataset en el Ejemplo 2.

m Cargar datos de deaR.

Para ver los datos disponibles en deaR, escribimos (ver Figura 20):
data(package="deaR”)

y ejecutamos la instruccién.

5> Obtener ayuda en R: https://www.r-project.org/help.html
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Figura 20. Datasets suministrados en deaR.

[E] C:/Users/Vicente/Desktop/Paper_1 - RStudio - olEN
file Edit Code View Plots Session Build Debug Profle Tools Help

Q| sesion_2.R* R data sets = Environment History Connections =

2 [ | [P import Dataset = = & List ~
A & Global Environment =

Data

Data sets in package ‘deaR’:

Coll Blasco_2006 Data: Coll and Blasco (2006). -
= — , coll_glasco. 6 obs. of 5 variables
Departments Data: Temkins and Green (1988). il 20 d
Doyle_Green_1994 Data: Doyle and Green (1994).
Econcmy Data: Wang and Lan (2011).
EconomyLong Data: Wang and Lan (2011).
Electric_plants Data: F4re, Grosskopf and Kokkelenberg
(1989} .
Fortune500 Data: Zhu (2014).
Fried1993 Jﬁz;]t‘riad, Knox Lovell and Schmidt Files || Piots | Packuges | Help | Miswer =
Golany Roll 1989  Data: Golany and Roll (1989). Ol NewFolder | @ Delete =] Rename | & More -
Guo_Tanaka_ 2001 Data: Guo and Tanaka (2001). € Users ~ Vicente = Desktop - Paper_1 R
Hotels Data: Wu, Tsai and Zhou (2011). i = PP
Hua Bian 2007 Data: Hua and Bian (2007). = -
Kao Liu 2003 Data: Kao and Liu (2003). v : 3
) = @ Rpata 2aK8 Nov 2, 2018, 11:09 AM
Console C:/Users/Vice Desktop/Paper_1 =1
2 3 ” o 5 “ | Rhistor 1258 Nov 2, 2018, 11:09 AM
R is a collaborative project with many contributors. e g ¥
Type 'contributors()' for more information and _| Coll_Blasco_2006.xlsx 84 KB Oct 14, 2018, 202 PM
'citation(Q' on how to cite R or R packages in publications. | paper_1.Rproj 2188 Nov 2, 2018, 11:17 AM
@] sesion_1.R 478 Nov 1, 2018, 11:26 AM

Type 'demo()' for some demos, 'help()' for on-Tine help, or
'help.start()' for an HTML browser interface to help. @ | sesion_2R 918 Nov 2, 2018, 11:09 AM
Type 'q()' to quit R.

[workspace loaded from C:/Users/vicente/Desktop/Paper_1/.RData]

> data(package="dear™")

>

Para cargar un dataset se utiliza la funcion data(). Por ejemplo, vamos a cargar los datos de
Tomkins y Green (1988)°. El nombre de este dataset es “Departments”. Por tanto, escribimos
(ver Figura 21):

data(“Departments”)
en el script “sesion2.R”. Si queremos visualizar los datos escribimos (ver Figura 21):

View(Departments)

Figura 21. Cargar y visualizar datos.

(2] C/Users/Vicente/Desktop/Paper_1 - RStudio - g “_
File Edit Code View Plots Session Buld Debug Profile Tools Help

Q| sesion_2R Depariments _| R data sets - Environment  History Connections =
Source on Save R #Run | b= Source = 4 [ | % import Dataset = | & List ~

% Tibrary(deaR) ) Global Environment =

3 Tibrary(readx1) Data

4 Coll_Blasco_2006 <- read_excel("Coll_Blasco_2006.x1sx") »Col1_Blasco_20.. 6 obs. of 5 variables

5 -

6 data(package-"dear™ ) Departments 20 obs. of 11 variables

8 darta("pepartments')

9 view(Departments)

10
Files Plots Packages Help Viewer (e
Q] New Folder | @ | Delete = Rename | 4GF More =
C: © Users - Vicente - Desktop - Paper_1 B
A Name Size Modified
10:1 | (Top Level) = R Saript 2 S
— @) RData 2B KB Nov 2, 2018, 11:09 AM
Cansole C:/Users/Vicente/Deskto - i
> Tibrary(deaR | Rhistary 1258 Nov 2, 2018, 11:09 AM
> Tibrary(readx1) __| Coll_Blasco_2006.xlsx BAKB Oct 14, 2018, 202 PM
2 " " >

> Coll ,B!asco,ZEUb <- read_excel("Coll_Blasco_2006.x1sx™") % Paper_1Rproj 2188 Nov 2, 2018, 11:17 AM
> data(package="deaR'")
> data("Departments™) @) sesion_1.R 478 Nov 1,2018, 11:26 AM
> View(Departments) O] sesion_2R 1578 Nov 2, 2018, 11:28 AM
>

Ejecutamos las instrucciones haciendo clicen ~#Run  (ver Figura 22).

® Tomkins, C.; Green, R. (1988). "An Experiment in the Use of Data Envelopment Analysis for Evaluating the
Efficiency of UK University Departments of Accounting”, Financial Accountability and Management, 4(2), 147-
164. https://doi.org/10.1111/j.1468-0408.1988.tb00296.x
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Figura 22. Visualizacion de “Departments”.

[Z] C:/Users/Vicente/Desktop/Paper_1 - RStudio o @n_
File Edit Code View Plots Session Build Debug Profile Tools Help

0] sesion_2.R* 'R data sets [ Environment History Connections -

’

" Filter T 1 #* Import Dataset ~ | & List ~
“  Departments Undergrad Research_post Taught_post Res_co_income Oth } Global Environment ~
1 Departmentl 128.70 4 3 o [~ Data
2 Department2 5335 0 0 9 DCol1_Blasco_20_6 obs. of 5 variables
3| Departmenta T e i g € Departments 20 obs. of 11 variab e§>
4 Departmentd 80.03 4 0 0
5 Department5 119.85 3 14 0
6 Departmentt 112.69 4 25 150
7 Department? 120.58 7 69 0 Files Plots Packages Help Viewer ==
8 Departmentd 197.26 4 10 2182 @ NewFolder | © Delete _» Rename = 4gF More -
9 Department9 86.20 0 1" 16486 w C: © Users = Vicente - Desktop - Paper_1 ®
£ X A Name Size Modified
Showing 1 to 10 of 20 entries T .
— @] RData 2.8KB Nov 2, 2018, 11:09 AM
Console C:/Users/Vicent aper_1/ —
> Tibrary(dear) Y] Rhistory 1258 Nowv 2, 2018, 11:09 AM
> library(readx1) | Coll_Blasco_2006.x1sx 84 KB Oct 14, 2018, 2:02 PM
> Cc11_B1asco_2|CIIDB <: read_excel ("Col1_Blasco_2006.x1sx") ® Poper_i.ipio) 2188 Nov2,2018, 11:17 AM
> data(package="deaR")
> data("Departments") @] sesion 1R 47 B Nov 1,2018, 11:26 AM
> View(Departments) 0] sesion_2.R 918 Nov 2, 2018, 11:09 AM

>

Observad que ahora tenemos dos objetos (“Coll Blasco 2006” y “Departments”).
“Departments” es un dataframe que consta que 20 observaciones (DMUs) y 11 variables.

Ahora, guardamos “sesion_2.R” y cerramos el proyecto “Paper_1". Salimos de RStudio.

7.2. Adecuar los datos al formato de deaR.

Una vez cargados los datos, el siguiente paso es adecuarlos al formato que utiliza deaR para
leerlos.

deaR dispone de tres funciones de lectura de datos. Cada formato de lectura responde a una
determinad tipologia de modelo DEA:

read_data(): si vamos a ejecutar un modelo DEA convencional (o clasico).
read_malmquist(): si vamos a aplicar el indice de productividad de Malmquist.

read_data_fuzzy(): si vamos a ejecutar un modelo DEA con datos inciertos (DEA
fuzzy).

7.2.1. Ayuda de deaR’.

Usando la ayuda de deaR podemos aprender cdmo usar una funcién especifica. Accediendo
a la ayuda de deaR podemos leer sobre los argumentos de la funcién o sobre ejemplos sobre
como usar la funcién. Vamos a ver cémo usar la funcion de ayuda con el Ejemplo 3.

7 Getting help with R: https://www.r-project.org/help.html
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dR

m Usando la

ayuda de deaR.

1. Abrimos el proyecto “Paper_1" y creamos un nuevo script. Llamamos a este script:
“ejemplo_read_data”

2. Cargamos el paquete deaR

3. Cargamos los datos de deaR: “Coll_Blasco _2006" (ver Figura 23).

Figura 23. Cargar dataset: “Coll_Blasco_2006"

[7) C/Users/Nicente/Desktop/Paper_1 - Rstudio - oIEN
Fle Edt Code View Plots Session Buid Debug Profile Tooks Help
0] gjemplo_read_dataR* —["  Environment History Connections =0
: Sourceon Save | O ' - SRun | o Source = # F | £ import Dataset » | & List
% Tibrary(deaR) "} Global Environment =
3 data("Coll_Blasco_2006") Values
4 Col1_Blasco_20.
5
Files Plots Packages Help Viewer =N
Q) New Foider | D Delete = Rename | gk More -
R

C: > Users > Vicente » Desktop * Paper_1

A Name Size
41 (Top Level) = R Script * t
p= @] RData 2.8KB
Console C:/Users/Vicente/Desktop/Paper =)
P SECU, SECU ], Seleyudl, uiion = Y] Rhistory 4748
| Coll_Blasco_2006.xlsx 84 KB
Attaching package: ‘deaR’ &l Paper_1.Rproj 2188
. . . @ sesion_1R 478
The following object is masked _by_ ‘.GlobalEnv’: n
@ sesion 2R 1578
coll1_Blasco_2006 @ | ejemplo_read_dataR 0B

warning message:

package ‘dplyr' was built under R version 3.4.4

> data("Coll_Blas
>

€0_2006")

Modified

Nov 2, 2018, 11:09 AM
Nov 2, 2018, 5:44 PM
Oct 14, 2018, 202 PM
Nov 2, 2018, 5:44 PM
Nov 1,2018, 11:26 AM
Nov 2,2018, 11:28 AM
Nov 2, 2018, 5:45 PM

Para acceder a la documentacion de las funciones de deaR utilizamos la funcidn
help(). Escribimos:

help(package="deaR").

En el menu Help (ver ventana inferior izquierda) aparecera un listado con todas las
funciones y datos de deaR. Es la documentacién de deaR (ver Figura 24).

Figura 24. Ay

uda de deaR.

7] C/Users/Vicente/Desktop/Paper_1 - RStudio - oIEN
File Edit Code View Plots Session Build Debug Profile Tools Help
0] gjemplo_read_dataR* [  Environment History ~Connections =
| | ISourceonSave @ {7~ " Source = 2 | CP* import Dataset = | & List =
:; Tlibrary(deaR) b Global Environment =
3 data("Coll_Blasco_2006™) Values
4 Coll_Blasco_20.
5 [help(package="dear™")
6
7|
Files Plots Packages Viewer =
o B 0
R: Conventicnal and Fuzzy Data Envelopment Analysis =
"
71| (lop Leve) wsopt - Conventional and Fuzzy Data

The following ob
filter, lag
The following ob

intersect, s

jects are masked from ‘package:stats’:
o)

jects are masked from ‘package:base’:

- o - Envelopment Analysis R
Attaching package: ‘dplyr’

etdiff, setequal, union

|Docu mentation for package ‘deaR’ I./ersion

warning message: 1.0
package ‘dplyr' was built under R version 3.4.4
> data("Coll_Blasco_2006") . PTI il

> help(package=",
>

'deaR™)
v Heln Paaes
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Tutorial: Data Envelopment Analysis with deaR dR

La funcién read_data().

Una vez hemos accedido a la documentacién (ayuda) de deaR, haciendo clic sobre
“read_data” obtendremos la ayuda especifica de esta funcién. También podemos obtener el
mismo resultado si en el script escribimos

help(read_data) (o ?read_data)

y ejecutamos la instruccion.

En la seccién Usage se muestran todos los argumentos de la funcidn read data(), y son
explicados brevemente en la seccidon Arguments (ver Figura 25).

Figura 25. Ayuda de la funcién read_data().
)

C:/Users/Vicente/Desktop/Paper_1 - RStudio - a n_

File Edit Code View Plots Session Build Debug Profile Tools Help

@ | ejemplo_read_data.R — Environment History Connections

1
2
3
4
5
6

6:1

Console C:/Users/V

Attaching package: ‘deaRr’

The following object is masked _by_ ‘.Globalenv':

Tibrary(deaR)

—

, 2
Source on Save K{L A - = Run | *% Source ~ 2 KH # Import Dataset ~ | & List ~

b Global Environment ~

data("col1_Blasco_2006") values

Coll_Blasco_20.

help(package="deaRr")
I

Files Plots Packages Viewer =0
§ | &4

R:read data ~

(Top Level) = rsoer » (read_data .

.. Description
This function creates, from a data frame, a deadata sfructure, which is as list
with fields input, output, dmunames, nc_inputs, nc_outputs,

nd inputs, nd outputs.

Col1_Blasco_2006

Warning message:

package ‘dplyr’ was built under R version 3.4.4

read data(datadea,

> data("Coll_Blasco_2006") ni = NULL,
> help(package="deaR") no = NULL,
dmus = 1, v

>

La funcién read_data() tiene los siguientes argumentos:

datadea: Se refiere al conjunto de datos a analizar (tiene que ser una dataframe).

dmus: Indicar el nUmero de la columna donde se encuentran las DMUs. Por defecto
deaR considera que las DMUs se encuentran en la primera columna.

ni: Es el nimero de inputs.
no: Es el nimero de outputs.

inputs: En lugar de indicar el nimero de inputs se puede indicar el nimero de las
columnas donde se encuentran los inputs.

outputs: En lugar de indicar el numero de outputs se puede indicar el nimero de las
columnas donde se encuentran los outputs.

nc_inputs: Si entre los inputs hay inputs no controlables se puede indicar qué input
es no controlable.

nc_outputs: Si entre los outputs hay outputs no controlables se puede indicar qué
output es no controlable.
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Tutorial: Data Envelopment Analysis with deaR dR

e nd_inputs: Si entre los inputs hay inputs no discrecionales se puede indicar qué input
es no discrecional.

e nd_outputs: Si entre los outputs hay outputs no discrecionales se puede indicar qué
output es no discrecional.

e ud _inputs: Si entre los inputs hay inputs no deseables (bad inputs) se puede indicar
qgué input es no deseable.

e ud_outputs: Si entre los outputs hay outputs no deseables (bad outputs) se puede
indicar qué output es no deseable.

En el Ejemplo 4 se explica cdmo usar la funcién read_data(). La documentacién de deaR
proporciona ejemplos de todas las funciones del paquete.

320 X:N Usando la funcidn read_data().

En este momento, tenemos cargado el dataset “Coll_Blasco 2006”. Este dataset es un
dataframe que tiene 6 DMUs (columna 1) con 2 inputs (columnas 2 y 3) y 2 outputs
(columnas 4y 5).

Supongamos que queremos analizar la eficiencia de estas DMUs y que para ello vamos a
utilizar el modelo DEA BCC.

Como el modelo DEA BCC es un modelo DEA convencional (no es fuzzy), lo primero que
tenemos que hacer es adecuar los datos Coll_Blasco_2006 al formato que utiliza deaR. Para
ello es para lo que utilizamos la funcion read_data().

Escribimos en el script “ejemplo_read_data” lo siguiente (ver Figura 26):

data_example <- read_data(Coll_Blasco_2006, ni=2, no=2)

Muy importante: Lectura y comprensién de la instruccion.

La parte derecha del simbolo de asignacién (<-) esta diciendo: lee los
datos (read data) en Coll _Blasco 2006 que tiene 2 inputs (ni=2) y 2
outputs(no=2). Las DMUS se encuentran en la primera columna
(dmus=1). Este argumento no aparece en la funcién porque es el valor
por defecto.

El resultado de la funcion lo asignas (<-) al objeto “data_example”.

Ejecutar la instruccion (= Run ).

Observad como ahora en el Environment aparece el objeto “Coll_Blasco_2006" y el objeto
“data_example”. Observad también que “data_example” es una lista de 9 elementos (ver
Figura 26).
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Figura 26. Uso de la funcion read_data().

e C:/Users/Vicente/Desktop/Paper_1 - RStudio - o IEl
File Edit Code View Plots Session Build Debug Profile Tools Help

') gemplo_read_dataR* - Histnry Connections "
| Source on Save FaRd *Run | O Source = - ¥ List =

8 Import Dataset ~

% Tibrary(deaR) ™} Global Environment =
3 data("coll_Blasco_2006" Data
! ” ’ Coll_Blasco_20.. 6 obs. of 5 variables
; help(package="dear") | data_example List of 9 |
7 data_example <- read_data(datadea = Coll_Rlasco_2006,
8 ni =2,
9 no = 2)
10
Files Plots Packages Help Viewer =
O
R: read_data *
read_data i
10:1 (Top Level) = R Seript 3 =
Console C:/Users/Vicente/Desktop/Pape =[_ Description
The following object is masked _by_ ‘.GlobaleEnv': o

This function creates, from a data frame, a deadata structure, which is as list
coll_Blasco_2006 with fields input, output, dmunames, nc_inputs, nc_outputs,
nd_inputs, nd outputs.
warning message:

package ‘dplyr’ was built under R version 3.4.4 Usage

> data("Coll1_Blasco_2006")

> help(package="deaR") read data(datadea,

> data_example <- read_data(datadea = Col1_Blasco_2006, ni = NULL,
+ ni =2, no = NULL,
+ no = 2) dmus = 1,

(& E] @_f: E R m|@§& -';/{*G‘ |§| O‘"W'Q:\‘fj"é'-eﬁa@s;ﬂmwrs@:m o

Ahora los datos estan preparados para ejecutar cualquier modelo DEA convencional (ver
seccion 7.3.). En este caso deberiamos utilizar el objeto “data_example”.

Recomendacion: practicar la funcidén read_data() con los ejemplos que aparecen en la ayuda
del paquete.

Guardar “ejemplo_read_data.R"”.

7.2.3. Lafuncion read_malmquist().

Si tenemos datos temporarles y queremos analizar la eficiencia y la productividad de un
conjunto de DMUs con el indice de Productividad de Malmquist, tenemos que utilizar Ia
funcién read_malmquist() para adecuar los datos al formato de lectura de deaR.

Con deaR los datos temporales pueden estar en dos formatos:

e Formato ancho: las DMUs vy los inputs y outputs de los diferentes afos por
columna. Por ejemplo, ver el dataset de deaR “Economy”® (Figura 27).

e Formato largo: Periodo de tiempo por columna. DMUs, inputs y outputs por
columna, pero agrupados por el periodo de tiempo. Por ejemplo, ver el dataset
de deaR “EconomylLong” (Figura 28).

En el siguiente ejemplo intentamos mostrar la explicacion anterior.

m Datos en formatos anchoy largo.

Ahora, vamos a mostrar estos diferentes formatos de datos. Para eso:

1. Creamos un nuevo script y lo Ilamamos “ejemplo_read_malmaquist”.

8 Wang, Y.; Lan, Y. (2011). "Measuring Malmquist Productiviy Index: A New Approach Based on Double
Frontiers Data Envelopment Analysis". Mathematical and Computer Modelling, 54, 2760-
2771. https://doi.org/10.1016/j.mcm.2011.06.064
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Tutorial: Data Envelopment Analysis with deaR

d

Nota: Si cerramos la session de trabajo, tenemos que abrir el proyecto “Paper_1" y
luego crear el script. En este caso, no tenemos que olvidar cargar nuevamente deaR.

Cargamos el dataset de deaR: “Economy”.

3. Visualizamos “Economy” (ver Figura 27). Este objeto (dataset) estd formado por 31
DMUs con 2 inputs (Capital y Labor) y 1 output (G/OV) para 5 afios (desde 2005 hasta
2009). “Economy” es un dataset en formato ancho.

Figura 27. Datos en formato ancho: “Economy”.

(2) C:/Users/Vicente/Desktop/Paper_1 - RStudio - g “
File Edit Code View Plots Session Build Debug  Profile Tools Help
T B —— =
Filter T KH #* Import Dataset = & List =

“ DMUs [< Lab 05 < 1 Global Environment =

1 Beijing 12829.79 11697 £946.07 14244.40 117.3¢~ Data

2 Tianjin 6347.92 12247 6774.10 7129.02 11632 Coll_Blasco_20. 6 obs. of 5 variables

3 Hebei 9473.70 29221 11008.12 11250.85 303.3¢ dataexample Lisl ol 9

Economy 31 obs. of 16 variables =

4 Shanxi_1 7045.09 213.20 485091 8865.50

5 Neimenggu 4595.89 8370 299559 5605.92

6 Liaoning 11902.12 27655 10814.51 14140.89

7 Jilin 4506.88 101.83 3791.96 5449.59 105.21 Files Plots Packages Help Viewer o

8 Heilongjiang 517447 136.85 471491 5690.43 14031 € NewFolder | © Delete = Rename | g More -

9 Shangai 15905.94 25963 15767.51 17926.10 266.8 v C: © Users » Vicente * Desktop ~ Paper_1 L
S ad A Name Size Modified
Showing 1 to 10 of 31 entries ,iL .

@) RpData 28K8 Nov 2, 2018, 11:09 AM
top =
o ] .Rhistory 6458 Nov 2, 2018, 5:52 PM
_| Coll_Blasco_2006.xlsx 84 KB Oct 14,2018, 2.02 PM

WarnsHy mastans: " g 97 ejemplo_read_dataR 678 Nov 2, 2018, 5:52 PM
package ‘dplyr’ was built under R version 3.4.4
> data("coll_Blasco_2006™) R Paper_1.Rproj 2188 Nov 2, 2018, 5:53 PM
> he1p(pﬂtka?e="dEaR") s 0 sesion_1.R 478 Nov 1, 2018, 11:26 AM
> data_example <- read_data(datadea = Coll_Blasco_2006, .
z e (m. o 0' sesion_2.R 1578 Now 2, 2018, 11:28 AM
+ no = 2) 9] ejemplo_read_data_malmquistR oB Nov 2, 2018, 7:13 PM
> data("Economy')
> View(Economy)
>

Ahora cargamos el dataset “EconomylLong”.

Visualizar “EconomyLong” (ver Figura 28). Este nuevo objeto de R (que es un dataset)
tiene 155 observaciones (31 DMUs x 5 years), con 2 inputs (Capital y Labor) y 1
output (G/OV). La columna Period se refiere al periodo de tiempo 2005 a 2009.

Figura 28. Datos en formato largo: “EconomylLong”.

data("EconomyLong")
View(EconomyLong)

(2] C:/Users/Vicente/Desktop/Paper_1 - RStudio - a n_
File Edit Code View Plots Session Build Debug Profile Tools Help
dataR® @ | ejemplo_read_data_malmquistR* Economy » ..["  Envirenment History Connections =
Filter > | #* Import Dataset = ?’ List =
* DMUs Period Capital Labor Glov T Global Environment ~
1 Beiing 2005 12829.79 11697 6946.07 ~ Data
2 Tianjin 2005 6347.92 12217 €774.10 Col1_Blasco_20.. 6 obs. of 5 variables
3 Hebei 2005 9473.70 29221 11008.12 ) data_example Listof 9 X
) Econom 6 _variables
4 Shanxi_1 2005 7045.09 21320 485091 =
> EconomyLong 155 obs. of 5 variables
5 Neimenggu 2005 4595.89 8370 299559
6 Lisoning 2005 1190212 27655 1081451
7 Jiin 2005 4506.88 10183 | 3791.96 Files Plots Packages Help Viewer =
8 Heilongjiang 2005 5174.47 13685 471491 Q) NewFolder | @ Delete 4 Rename | 43 More -
9 Shangai 2005 15905.94 25963 1576751 C: » Users > Vicente » Desktop ° Paper_1 §
- mmmm e imm mmime mmmam s i A Name Size Modified
Showing 1 to 10 of 155 entries t
S - @] RData 28K8 Nov 2, 2018, 11:09 AM
Console C:/Users/Vicents aper.1 =C
warning message: % | Rhistory 6458 Nov 2,2018, 5:52 PM
package ‘dplyr’ was built under R version 3.4.4 ] Coll_Blasco_2006.xdsx 84 KB Oct 14, 2018, 2:02 PM
" "
> data("Col1_Blasco_2006") '] ejemplo_read_dataR 678 Nov 2,2018, 552 PM
> help(package="deaR")
> data_example <- read_data(datadea = Coll_Blasco_2006, &/ Paper_1.Rproj 2188 Nov 2, 2018, 5:53 PM
+ ni= 2, @] sesion_1.R 478 Nov 1,2018, 11:26 AM
i poesrd) 9 sesion_2R 1578 Nov 2, 2018, 1128 AM
> data("Economy™) 9 | sesion_2. ov 2, ;113
> View(Economy) @) ejemplo_read_data_malmquistR 0B Nov 2,2018, 7:13 PM
>
>
>
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Tutorial: Data Envelopment Analysis with deaR dR

Nota: observad como en Environment (ventana superior derecha) se van listando todos los
objetos que vamos creando durante la sesién de trabajo.

La funcién read _malmaquist() tiene los siguientes argumentos®:

datadea: Se refiere al conjunto de datos a analizar (tiene que ser una dataframe).
nper: Es el numero de periodos de tiempo (con datos en formato wide)

percol: Es el nimero de la columna que contiene el periodo de tiempo (con datos en
formato long).

I"

arrangement: Indicar “horizontal” con datos en formato wide y “vertical” con datos

en formato long.

dmus: Indicar el nimero de la columna donde se encuentran las DMUs. Por defecto,
deaR considera que las DMUs se encuentran en la primera columna.

ni: Es el nimero de inputs.
no: Es el nimero de outputs.

inputs: En lugar de indicar el nimero de inputs se puede indicar el nimero de las
columnas donde se encuentran los inputs.

outputs: En lugar de indicar el nUmero de outputs se puede indicar el nimero de las
columnas donde se encuentran los outputs.

nc_inputs: Si entre los inputs hay inputs no controlables se puede indicar qué input
es no controlable.

nc_outputs: Si entre los outputs hay outputs no controlables se puede indicar qué
output es no controlable.

nd_inputs: Si entre los inputs hay inputs no discrecionales se puede indicar qué input
es no discrecional.

nd_outputs: Si entre los outputs hay outputs no discrecionales se puede indicar qué
output es no discrecional.

ud_inputs: Si entre los inputs hay inputs no deseables (bad inputs) se puede indicar
gué input es no deseable.

ud_outputs: Si entre los outputs hay outputs no deseables (bad outputs) se puede
indicar qué output es no deseable.

La version actual de deaR no permite la presencia de inputs/outputs no deseables para
calcular el indice de productividad de Malmquist. Esta caracteristica sera incorporada en una
version posterior.

En los Ejemplos 6 y 7 podemos ver como usar la funcién read_malmaquist() con datos en
formato ancho y largo, respectivamente.

°® Podemos utilizar la ayuda de deaR: help(read_malmaquist).
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IlyT XA Funcion read_malmaquist() con datos en formato ancho.

Para este ejemplo vamos a usar el dataset “Economy”. Este dataset ya lo tenemos cargado
en nuestra sesion de trabajo.

Para adaptar “Economy” al formato de lectura usado por deaR, escribimos en el script
(“ejemplo_read_malmquist”) el siguiente texto:

data_example_1 <- read_malmquist(Economy,

nper=5,

arrangement="horizontal”,

ni=2,
no=1)

Al ejecutar la instruccidn se crea un nuevo objeto (“data_example_1"), que es listado en el
Environment (ver Figura 29).

Figura 29. Funcién read_malmquist() con datos en formato ancho.

(=)

C:/Users/Vicente/Desktop/Paper_1 - RStudio

File Edit Code View Plots Session Build Debug Profile Tools Help

_read_data.R* @ | gjemplo_read_data_malmaquist.R* Economylong Economy 3% e [T

| Source on Save

Q -l *Run | °% Source  ~

1 data("Economy™)
2  Vview(Economy)
3
4 data("EconomyLong")
5 View(Economylong)
6
7 |Jdata_example_1 <- read_malmquist(Economy,
8 nper=5,
9 arrangement="horizontal",
10 ni=2,
il no=1)
12
13
14
121 (Top Level) < R Script 5
Console C:/Users/Vicen =

> data("Economy™)

> View(Economy)

> data("Economylong™)
> View(EconomyLong)

> data_example_1 <- read_malmquist(Economy,

Yo+ o+ o+ o+

nper=5,
arrangement="horizontal",
ni=2,

no=1)

Environment  History Connections

;
1 | £* Import Dataset = ¥

} Global Environment ~

Data
»Coll1_Blasco_20.. 6 obs. of 5 variables
2 dat i of 9
o data_example_1 List of 5
» Economy 31 obs. of 16 variables
2 EconomyLong 155 obs. of 5 variables

Files Plots Packages Help Viewer

{NewFulder Q Delete = Rename

‘:‘} More ~

C: > Users » Vicente » Desktop ~ Paper_1

A Name
t.
@] RData
| .Rhistory
| Coll_Blasco_2006.xlsx
=] ejemplo_read_data.R
& Paper_1.Rproj
@ sesion_1.R
@] sesion_2R
0] ejemplo_read_data_malmgquistR

Size

2.8 KB
645 B
84 KB
67 B

2188
47 B

157 B
301B

Modified

Nov 2, 2018
Nov 2, 2018
Oct 14, 201¢
Nov 2, 2018
Nov 2, 2018
Nov 1, 2018
Nov 2, 2018
Nov 2, 2018

Como podemos ver, “data_example_1" es una lista de 5 componentes. Si hacemos clic sobre
el icono situado junto al nombre del objeto podemos ver su estructura (ve Figura 30).
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Figura 30. Estructura de “data_example_1".

e C:/Users/Vicente/Desktop/Paper_1 - RStudio =0 n_
File Edit Code View Plots Session Build Debug Profile Tools Help

o_read_data.R @) ejemplo_read_data_malmquistR Economylong Economy 3 [~  Environment History Connections -
; SourceonSave | (O 7 - *Run | o Source E = | #* Import Dataset = )’ List =
1 data("Economy™) B it s
2 View(Economy)
3 Data A
4 data("Economylong™) ©Col1_Blasco_20.. 6 obs. of 5 variables
(55 Vview(EconomyLong) O data_example List of 9
7 data_example_1 <- read_malmquist(Economy, ©Mata_example_1 List of 5
8 nper=>5, i i Period.1:L1st of 9
13 ﬁ:z;"gemenh horizontal”, ..$ input : num [1:2, 1:31] 12830 117 6348 122 9474 ...
11 no:lj .. ..- attr(*, "dimnames")=List of 2
12 e vo ..% : chr [1:2] "Capital2005" "Labor2005"
. .. ..% : chr [1:31] "Beijing" "Tianjin" "Hebei" "Shal
12:1 (Top Level) = R Script < .$ output : num [1, 1:31] 6946 6774 11008 4851 2996 ..
ve o.— attr(*, "dimnames")=List of 2
Console C:/Users/Vicente/Desktop/Paper_1/ =C . .. ..% : chr "GIOV2005"

~ " Y "o i N TR ¢ ENTINT}
WirAiG nessages .. ..% 1 chr [1:31] "Beijing" "Tianjin" "Hebei Sha.

package ‘dplyr’ was built under R version 3.4.4 .3 dmur_\ames : Factor w/ 31 levels "Anhui","Beijing",...

> data("Col1_Blasco_2006") ..$ nc_inputs : NULL

> help(package="deaR") € o madondes ML d
> data_example <- read_data(Coll_Blasco_2006, ni=2, no=2) Files Plots Packages Help Viewer =L
> data("Economy") o o - =

> View(Economy) | New Folder Delete = Rename ‘.ﬁ More ~

> data("EconomyLong") C:  Users = Vicente = Desktop = Paper_ 1 3

> View(EconomyLong) A Name Sjee Modified

> data_example_1 <- read_malmquist(Economy, Y o
¥ nper=5, "

+ arrangement="horizontal", @] RData 28KB Nov 2, 2018, 11:09 AM

. Elj) “] Rhistory 53 K8 Nov 9, 2018, 1201 PM

>

_| Coll_Blasco_2006.xlsx 84 KB Oct 14, 2018, 2:02 PM

ST WA Funcion read_malmquist() con datos en formato largo.

Ahora, vamos a utilizar el dataset “Economylong”. En la Figura 31 podemos ver la
instruccién utilizada para adaptar los datos al formato de lectura de deaR.

Figura 31. Funcién read_malmquist() con datos en formato largo.

(2] C:/Users/Vicente/Desktop/Paper_1 - RStudio - o IEl
File Edit Code View Plots Session Build Debug Profile Tools Help

d_dataR* 8] ejemplo_read_data_malmquist.R* Economy Economylong % 33 e [ i History G i -
I Sourceon Save | O - +Run | *% Source ~ | = = H #* Import Dataset = )’ List =
é ViEmLECOnomy ) “ [ Global Environment ~
4 data("EconomyLong") Data
g Vview(EconomyLong) D Col1_Blasco_20.. 6 obs. of 5 variables
7 data_example_1 <- read_malmquist(Economy, © data_exampTe List of 9
8 nper=5, . data examnle ist of 5
13 ﬁ:_'i;ngement= hontzontal 7 data_example_2 List of 5
i1 no:l)’ obs. of 16 variables
12 ) @ EconomyLong 155 obs. of 5 variables
13 |data_example_2 <- read_malmquist(EconomylLong,
14 percol=2,
15 arrangement="vertical”,
16 ni=2 Files Plots Packages Help Viewer =
,
17 no=1) Q) NewFolder | © Delete | Rename | 4G More ~
18
1814 (Top Level) = R Script : C: » Users » Vicente » Desktop - Paper_1 b4
4 Name Size Modified
Console C:/Users/Vicente/Desktop/Paper_1/ = ﬁL .
* . no=1) " @ RData 28K8 Nov 2, 2018, 11:09 AM
> data_example_2 <- read_malmquist(EconomylLong, : .
3 percol=5 ‘2] .Rhistory 645 B Nov 2, 2018, 5:52 PM
=2,
+ arrangement="vertical", | Coll_Blasco_2006.xlsx 84 KB Oct 14, 2018, 2:02 PM
3 Egj) ©') ejemplo_read dataR 678 Nov 2, 2018, 5:52 PM
> data_example_2 <- read_malmquist(Economylong, & Paper_1.Rproj 2188 Nov 2,2018, 5:53 PM
7 percol=2, . @] sesion_1.R 478 Nov 1,2018, 11:26 AM
+ arrangement="vertical", )
g ni=2 G’J sesion_2.R 157 B Nov 2,2018, 11:28 AM
=2,
+ no=1) @ ejemplo_read_data_malmquistR 3018 Nov 2, 2018, 7:43 PM
>

Guardamos el script “ejemplo_read_data_malmquist.R".
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7.2.4. Funcion read_data_fuzzy().

Si tenemos datos inciertos y queremos analizar la eficiencia de un conjunto de DMUs con un
modelo DEA fuzzy, tenemos que utilizar la funcién read_data_fuzzy() para adecuar los datos
al formato de lectura de deaR.

deaR puede trabajar con numeros fuzzy trapezoidales, triangulares simétricos y triangulares
no simétricos (ver Figura 32).

Figura 32. Numeros fuzzy.

Fuzzy numbers

mL mR

Trapezoidal

mL=mR

mL=mR Non-symmetrictriangular

Symmetric triangular dl . dR

La funcion read_data_fuzzy() tiene los siguientes argumentos?©:
e datadea: Se refiere al conjunto de datos a analizar (tiene que ser una dataframe).

e dmus: Indicar el nUmero de la columna donde se encuentran las DMUs. Por defecto
deaR considera que las DMUs se encuentran en la primera columna.

e Inputs.mL: columnas donde se encuentran los valores mL de los inputs.

e Inputs.mR: columnas donde se encuentran los valores mR de los inputs.

e Inputs.dL: columnas donde se encuentran los valores dL de los inputs.

e Inputs.dR: columnas donde se encuentran los valores dR de los inputs.

e Qutputs.mL: columnas donde se encuentran los valores mL de los outputs.
e QOutputs.mR: columnas donde se encuentran los valores mR de los outputs.
e QOutputs.dL: columnas donde se encuentran los valores dL de los outputs.

e Qutputs.dR: columnas donde se encuentran los valores dR de los outputs.

e nc_inputs: Si entre los inputs hay inputs no controlables se puede indicar qué input
es no controlable.

10 podemos utilizar la ayuda de deaR: help(read_data_fuzzy).
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e nc_outputs: Si entre los outputs hay outputs no controlables se puede indicar qué
output es no controlable.

e nd_inputs: Si entre los inputs hay inputs no discrecionales se puede indicar qué input

es no discrecional.

e nd_outputs: Si entre los outputs hay outputs no discrecionales se puede indicar qué
output es no discrecional.

e ud_inputs: Si entre los inputs hay inputs no deseables (bad inputs) se puede indicar
qué input es no deseable.

e ud_outputs: Si entre los outputs hay outputs no deseables (bad outputs) se puede
indicar qué output es no deseable.

En la version actual de deaR solo se tiene en cuenta los inputs/outputs no deseables en los
modelos fuzzy basados en el modelo DEA BCC.

Vemos un ejemplo.

Il kA Funcion read data_fuzzy().

1. Creamos un nuevo script y lo nombramos como: “ejemplo_read_data_fuzzy”

Nota: Si cerramos la sesion de trabajo tenemos que abrir primero el proyecto

“Paper_1" y luego crear el script. En este caso, no olvidar cargar deaR.

2. Cargamos el dataset “Leon2003” '

data(“Leon2003”).

Este dataset (ver Figura 33) esta formado por 8 DMUs con 1 input fuzzy triangular
simétrico (alpha es la apertura del input) y 1 output fuzzy triangular simétrico (beta
es la apertura del output).

Figura 33. Dataset: Leon2003.

(")

C:/Users/Vicente/Desktop/Paper_1 - RStudio

File Edit Code View Plots Session Build Debug Profile Tools Help

1ad_data_malmquistR*

DMU x alfa
1A 30 20
28 40 05
3 C 45 15
40D 6.5 05
5 E 70 20
6|F 8.0 05
7 6 100 1.0
8 H 60 05

Showing 1 to 8 of 8 entries

Console <

> data("Economy")

> View(Economy)

> data("EconomyLong™)
> View(EconomylLong)

Q | gjemplo_read_data_fuzzyR*

beta
3.0 1.00
25 1.00
6.0 1.00
40 1.25
5.0 050
35 0.50
6.0 050
20 1.50

> data_example_1 <- read_malmquist(Economy,

¥
+
+

> data("Leon2003")
> View(Leon2003)

>

nper=5,
arrangement="horizontal",
ni=2,

Environment  History Connections
14 #* Import Dataset ~ s
M Global Environment ~

Data

Coll_Blasco_20. 6 obs. of 5 variables

data_example List of 9
data_example_1 List of 5

Economy 31 obs. of 16 variables
Economyl ong 155 obs. of 5 variables

«ZTeon2003 8 obs. of 5 variableem

Files Plots Packages Help Viewer
Q@ NewFolder | @ Delete = Rename = 4gF More ~

C:  Users  Vicente > Desktop  Paper_1
A Name size
t.
@] RpData 28KB
7 Rhistory 6458
Coll_Blasco_2006xlsx 84KB
@] ejemplo_read_dataR 678
K| Paper_1.Rproj 2188
@ sesion_1.R 478
@] sesion_2.R 1578
@7 ejemplo_read_data_malmgquistR 3018
)

ejemplo_read_data_fuzzyR 08

Modified

Nov 2, 2018, 11:09 AM
Nov 2, 2018, 5:52 PM
Oct 14, 2018, 2:02 PM
Nov 2, 2018, 5:52 PM
Nov 2, 2018, 5:53 PM
Nov 1,2018, 11:26 AM
Now 2,2018, 11:28 AM
Nov 2, 2018, 7:43 PM
Nov 2, 2018, 8:22 PM

11 Leén, T.; Liern, V. Ruiz, J.; Sirvent, I. (2003). "A Possibilistic Programming Approach to the Assessment of
139, 407-419.https://doi.org/10.1016/S0165-

Efficiency with DEA Models",

0114(02)00608-5

Fuzzy Sets and Systems,
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dR

3. Ahora utilizamos la funcién read _data fuzzy() para adecuar los datos al formato de
lectura de deaR. Para ello, escribimos en el script:

data_example_3 <- read_data_fuzzy(Leon2003,

y ejecutamos la instruccion.

inputs.mL=2,
inputs.dL=3,
outputs.mL=4,
outputs.dL=5)

Nuestra sesidon de trabajo deberia parecerse a la siguiente captura de pantalla (ver

Figura 34):

Figura 34. Uso de la funcion read_data_fuzzy().

(2] C:/Users/Vicente/Desktop/Paper_1 - RStudio - o IEN
File Edt Code View Plots Session Build Debug Profile Tools Help
O | gjemplo_read_data_malmguistR* 0 | gjemplo_read_data_fuzzyR* Leon200°% o ™ Environment History Connections =
Source on Save A - *Run | % Source ~ o # Import Dataset ~ | & List ~
1 data("Leon2003"
Global E at ~
2  view(Leon2003) ke Bk oo
3 Data
4 Jdata_example_3 read_data_fuzzy(datadea - Leon2003, Coll_Blasco_20_ 6 obs. of 5 variables
5 dmus = 1, =z
6 Tt m =2, data_example L1‘st of 9
7 inputs.dL = 3, data_example_1 List of 5
8 outputs.mL = 4, data_exasala i of 5
9 outputs.dL 5 .
10 data_example_3 List of 9
Economy Bbs. of 16 variables
) EconomyLong 155 obs. of 5 variables
Leon2003 8 obs. of 5 variables
Files Plots Packages Help Viewer i
(Top Level) = Q) New Folder | @ Delete = | Rename | g More ~
e : C  Users  Vicente  Desktop ~ Paper_t L
- A Name Size Modified
> data_example_2 <- read_malmquist(EconomyLong, ¢
* percol=2, =
+ arrangement="vertical", @ Rpata 28KB Nov 2, 2018, 11:09 AM
e ni=2, Y] Rhistory 6458 Nov 2, 2018, 5:52 PM
” no=1)
> data_example_3 <- read_data_fuzzy(datadea = Leon2003, Coll_Blasco_2006.xIsx 84 KB Oct 14, 2018, 2:02 PM
+ dmus =1, @) ejemplo_read_dataR 678 Nowv 2, 2018, 5:52 PM
+ inputs.mL = 2, -
+ inputs.dL = 3, % Paper_1.Rproj 2188 Nov 2, 2018, 5:53 PM
+ outputs.mL = 4, 9] sesion_1R 478 Nov 1,2018, 11226 AM
i e @ sesion 2R 1578 Nov 2, 2018, 1128 AM
97 piemnia read data malmauist.R MR Nov 2. 2018.7:43 PM

En este ejemplo, inputs.dL=alpha y ouputs.dL=beta. Como estamos trabajando con
nuimeros fuzzy triangulares simétricos: inputs.dL=inputs.dR y outputs.dL=outputs.dR

Hemos creado un nuevo objeto: “data_example 3”. Este objeto es el que
utilizaremos para ejecutar un determinado modelo DEA fuzzy.

Guardamos “ejemplo_read_data_fuzzy.R”, cerramos el proyecto y salimos de RStudio.

7.3. Seleccionar y ejecutar un modelo DEA.

Una vez los datos estan preparados para que puedan ser leidos por deaR, el siguiente paso

consiste en seleccionar el modelo DEA y ejecutarlo.

En la version actual de deaR (version 1.0) se encuentran disponibles los siguientes modelos:

Conventional DEA models

Basic (radial) models (envelopment and multiplier forms)

Directional distance function model

(Weighted) Additive model

27
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Conventional DEA models
Super-efficiency additive model

Radial Super-efficiency model

(Weighted) Non-radial model

Preference Structure model

(Weighted) Slack-based model

(Weighted) Super-efficiency slack-based model
Cross-efficiency (crs*? and vrs3)
Bootstrapping (Simar and Wilson algorithm)
FDH model

Productivity

Malmquist index

Fuzzy DEA models

Kao and Liu model**

Possibilistic model

Guo and Tanaka model

Fuzzy cross-efficiency® (only crs)

En la ayuda de deaR podemos encontrar informacion sobre cémo utilizar las diferentes
funciones y ejemplos poniéndolas en practica.

Aunque los modelos DEA disponibles en deaR son los listados arriba, dada la flexibilidad con
la que se ha programado el paquete (y aqui reside una importante fortaleza de deaR), el
propio usuario puede experimentar, probar e implementar variantes de estos modelos. Por
ejemplo, si el usuario define apropiadamente los pesos en el “Modelo Aditivo”, puede
obtener los modelos MPI*®* o RAM?Y. Otro ejemplo. A partir del modelo “Preference
Structure” (modelo no radial ponderado) pueden calcularse los modelos “Cost Efficiency”,
“Revenue Efficiency” y “Profit Efficiency”.

A continuacién vamos a ver cémo utilizar la funcién model_basic() para calcular modelos
DEA basicos. Para ello:

e Abrir el proyecto “Paper_1" y crear un nuevo script. Llamarlo “ejemplo_basic”.
e Cargar deaR.
e Abrir la ayuda de deaR.

e Iralaayuda de la funcién model basic() (ver Figura 35). También podemos escribir:

12 ¢rs = rendimientos constantes a escala.
13 yrs = rendimientos variables a escala.
14 Este modelo DEA fuzzy se ha extendido para un amplio nimero de modelos DEA. Ver la ayuda del paquete:
help(“modelfuzzy_kaoliu”).
15 Basado en el modelo de Guo y Tanaka.
16 Measure of Inefficiency Proportions (MPI).
17 Range Adjusted Measure (RAM).
28
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help(“model_basic”)

Figura 35. Ayuda de la funcién model_basic().

[E] C:/Users/Vicente/Desktop/Paper_1 - RStudio - g “_
File Edit Code View Plots Session Build Debug Profile Tools Help
2 | ejemplo_basicR* - Environment History Connections =
z | [ Sourceonsave = O - FRun | o Source ~ T # Import Dataset + = & List ~
% Tibrary(dear) b Global Environment -
3 Ihe1p(package:"deaR")I
4
2
Files Plots Packages Help Viewer |
&] s

41 (Top Level) 5

Console C:/Users

Ihe Tollowing objects are masked Trom "package:stats’:

filter, lag

R Seript 5

The following objects are masked from ‘package:base’:

intersect, setdiff, setequal, union

warning message:

package ‘dplyr’ was built under R version 3.4.4
> help(package="deaR")

>

¥

R: Basic (radial) DEA model. =

model_basic {deaR} R Documentation

Q'F. IBasic (radial) DEA model.

Description

Solve input and output oriented basic DEA models (envelopment form) under
constant (CCR DEA model), variable (BCC DEA model), non-increasing, non-
decreasing or generalized returns to scale. By default, models are solved in a
two-stage process (DEA slacks are maximized)

The model_basic function allows to treat with non-discretional, uncontrollable and
undesirable inputs/outputs

< 3

La funcién model_basic() tiene los siguientes argumentos:

e datadea: Conjunto de datos en el formato de lectura de deaR.

e dmu_ref: Seleccién de un subconjunto de DMUs

e dmu_eval: DMUs a evaluar del subconjunto seleccionado.

e orientation: Orientacién del modelo: input, output o direccional.

e dir_input: Vector de direccidn input en modelos direccionales.

e dir_output: Vector de direccién output en modelos direccionales.

e rts: Rendimientos a escala del modelo (constantes, variables, no-crecientes, no-

decrecientes, generalizados).

e [:Siseleccionamos rendimientos a escala generalizados, limite inferior.

e U: Siseleccionamos rendimientos a escala generalizados, limite superior.

e Maxslack: Por defecto, las holguras son maximizadas en una segunda etapa.

e weight_slack_i: El usuario puede asignar pesos a las holguras inputs en la segunda

etapa.

e weight_slack o: El usuario puede asignar pesos a las holguras outputs en la segunda

etapa.

e vtrans_i: Con inputs no deseables y rendimientos constantes a escala el usuario
puede definir un vector de traslacién. Por defecto es el maximo mds 1.

e vtrans_o: Con outputs no deseables y rendimientos constantes a escala el usuario
puede definir un vector de traslacion. Por defecto es el maximo mas 1.

e compute_target: Calcula los targets en la solucién max slack.

29

©Coll-Serrano, V.; Benitez, R. and Bolds, V. (2018)



Tutorial: Data Envelopment Analysis with deaR dR

e compute_multiplier: Si el usuario quiere obtener los multiplicadores inputs y outputs
(forma multiplier).

e returnlp: Para cada DMU, devuelve el problema lineal de la primera etapa.

A continuacién, vamos a aprender cémo usar la funcion model_basic() haciendo los Ejemplos
9y 10. Para seguir estos ejemplos tenemos que cargar el dataset “PFT1981”18. Este dataset
estd formado por 70 DMUs con 5 inputs (Education, Occupation, Parental, Counseling,
Teachers) y 3 outputs (Reading, Math, Coopersmith). La Figura de abajo (Figura 36) muestra
las instrucciones que deberiamos escribir en el script “ejemplo_basic” para cargar los datos.

Figura 36. Dataset: PTF1981.

[E) C:/Users/Vicente/Desktop/Paper_1 - RStudio - g n_
File Edit Code View Plots Session Build Debug Profile Tools Help
@ | gjemplo_basicR* PFT1981 - Environment History Connections -
Filter # [ | [ Import Dataset =~ | & List ~
“ Site Education Occupation Parental Counseling Teachers Reading "} Global Environment -
1 Sitel 86.13 1624 48.21 4969 E] ~ Data
= P 5t 034 o e z J©PFT1981 70 obs. of 10 variables|
3 Site3 4312 11.31 38.19 35.03 g
4 Site4 24,96 6.14 24.81 25.15 7
5 Site5 11.62 2.21 6.85 6.37 4
6 Siteb 11.88 4.97 18.73 18.04 4
- il Girinisd Sk el 254 ! Files Plots Packages Help Viewer —{m|
8 Sited 20.79 12.97 54.85 3207 8 @ New Folder | @ Delete | Rename | 4G More -
9 Sited 34.40 11.04 38.16 4240 8 G C: » Users * Vicente » Desktop * Paper_1 .
< > 4 Name Size Modified
Showing 1 to 10 of 70 entries t .
— @ RData 28KB Nov 2, 2018, 11:09 AM
Console C:/Users/Vicente/Desktop/Paper_ =1 7 )
Tiiter, lag S "| .Rhistory 6.7 KB Nov 11,2018, 441 PM
| Coll_Blasco_2006.xlsx 84 KB QOct 14, 2018, 2:.02 PM
. : ¢ 2 ",
The following objects are masked from ‘package:base’: @Y cjernplo_busicR o Nov 4, 2018, 12:04 PM
intersect, setdiff, setequal, union @] ejemplo_read_data.R 1268 Nov 11,2018, 11:30 AM
. o ejemplo_read_data_fuzzy.R 0B Nov 2, 2018, 8:22 PM
warning message: B )
ackage ‘dplyr’ was built under R version 3.4.4 ‘:’J ejemplo_read_data_malmquistR 3018 Nov 8, 2018, 5:06 PM
> help(package="deaR") R Paper_1.Rproj 2188 Nov 14,2018, 7:03 PM
> data("PFT1981") @ P .
> View(PFT1981) | sesion_1.R 478 Nov 1, 2018, 11:26 AM
> @' sesion_2.R 157 B Nov 2, 2018, 11:28 AM

ST JER Funcion model_basic().

De las 70 DMUs (school sites) de “PTF1981”, hay 49 DMUs en Project Follow Through (PFT) y
21 DMUs en Non-Follow Through (NFT).

En este ejemplo, vamos a calcular la eficiencia de las 49 DMUS en PFT con el modelo DEA
CCR input-orientado.

En primer lugar, tenemos que usar la funcién read data() para adaptar los datos al formato
de lectura de deaR (ver seccién 7.2.2.). Ejecutar la instruccidn ¢ - = run

Ahora, tenemos que usar la funcién model _basic() porque queremos calcular la eficiencia
utilizando el modelo bdsico CCR (que es un modelo DEA convencional). Pero como sélo
queremos la eficiencia de las primeras 49 DMUs, que son las que participan en PFT,
utilizamos el argumento dmu_ref=1:49. Ademas, como queremos evaluar las 49 DMUs
utilizamos el argumento: dmu_eval=1:49. Por tanto, tenemos que escribir en el script
“ejemplo_basic” el siguiente texto:

18 Charnes, A.; Cooper, W.W.; Rhodes, E. (1981). "Evaluating Program and Managerial Efficiency: An Application
of Data Envelopment Analysis to Program Follow Through", Management Science, 27(6), 668-697.
https://pubsonline.informs.org/doi/abs/10.1287/mnsc.27.6.668
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result_pft <- model_basci(PFT1981,

dmu_ref=1:49,
dmu_eval=1:49,
orientation="i0”,
rts=“crs”)

y ejecutamos la instruccién (ver Figura 37).

Nota: También se puede seleccionar todas las instrucciones y ejecutarlas

conjuntamente con

= Run en lugar de hacerlo por separado.

t orientado para DMUs en PFT.

Figura 37. Ejecutando el modelo CCR inpu
(%)

dR

C/Users/Vicente/Desktop/Paper_1 - RStudio - d n_
File Edit Code View Plots Session Build Debug Profile Tools Help
9@ | gjemplo_basicR* —r History C = |
H [ SourceonSave A /- HRun | % Source ~ 2 | [?import Dataset - | & List ~
% Tibrary(dear) Tk Giobal Environment =
3  help(package="dear") Data
4 ) ) D data_basic List of 9
; data("pRTLIBL ) O PFT1981 70 obs. of 10 variables
7 # Adaptamos los datos al formato de lectura de deaR O result_pft List of 11
8 data_basic <- read_data(PFT1981,
9 dmus=1,
10 inputs=2:6,
11 outputs=7:9)
12
13 # Ejecutamos el modelo CCR input-orientado "
14 result_pft <- model_basic(data basic, F"f‘ Plots Packages Help Viewer =l
15 dmu_eval-1:49, Q0 NewFolder | © Delete = Rename = g More =
16 dmu_ref=1:49, ; . . "
17 orientation-"io", C: ~ Users - Vicente » Desktop - Paper_1
18 rts="crs™ A Name Size Modified
19 | | =
20
@ RpData 2.8 KB Nov 2, 2018, 11:09 AM
19:1 | (Top Level) 2 R Saript & ] Rhistory 29KB Nov 4, 2018, 10:52 AM
Console C:/Users/Vicer p/Pape s ] | Coll_Blasco_2006.xisx 8.4 KB Oct 14,2018, 2:02 PM
+ uuvt;.].u"ts;; Zé) ~ 9| ejemplo_read_dataR 678 Nov 2, 2018, 5:52 PM
> # Ejecutamos el modelo CCR input-orientado 97 ejemplo_read_data_fuzzy.R oB Nov 2, 2018, 822 PM
> result_pft <- mode'l,bazlc(dat?,?ai;c, 9 ejemplo_read_data_malmguistR 3018 Nov 2, 2018, 7:43 PM
+ mu_eval=1:49,
+ dmu_ref=1:49, %1 Paper_1.Rproj 2188 Nov 4, 2018, 10:48 AM
+ orientation="io", 0 sesion_1R 478 Nov 1,2018, 11:26 AM
+ res="crs" ;
> ) 97 sesion_2R 157 B Nov 2, 2018, 11.28 AM
. () aiemnln hacic R [3-F-3 Mo 2 2010 1919 Akd Y

ST DR Funcion model basic().

Llegados a este punto , é{podrias ejecutar el modelo DEA CCR input-orientado para las

DMUs en NFT? (DMUs en NFT son las

DMUs desde la 50 a la 70).

La respuesta a esta pregunta se encuentra en la siguiente pagina (Figura 38).
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orientado para DMUs en NFT.

Figura 38. Ejecutando el modelo CCR input
5]

File Edit Code View Plots Session
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1 Source on Save A S = Run e
o
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8 data_basic read_data(PFT1981,
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10 inputs=2:6,
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13 # Ejecutamos el modelo CCR input-orientado
14 result_pft <- model_basic(data_basic,
15 dmu_eval=1:49,
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19
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26
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* Source =
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2N NFT.

v
R Script =
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() variables
Oresult p st of 11

Files Plots Packages Help Viewer

Nov 2, 2018, 11:09 AM
Nov 4, 2018, 10:52 AM
Oct 14, 2018, 202 PM
Nov 2, 2018, 5:52 PM

> # Ejecutamos el modelo CCR

Vo o+t

input-orientado para DMUs en NFT.
> result_nft <- model_basic(data_basic,

dmu_eval=50:70,
dmu_ref=50:70,
orientation="io",
rts="crs")

Q, New Folder | © Delete < Rename ‘} More =
C:  Users © Vicente - Desktop = Paper_1
4 Name Size Modified
t
@] RData 28K8
“7 .Rhistory 29KB
| Coll_Blasco_2006.xIsx 84 KB
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9 ejemplo_read_data_fuzzy.R 0B
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N2 N9 1119 AR

Guardamos el script “ejemplo_basic”.

7.4. Extraccion de los principales resultados.

En los Ejemplos 9 y 10, después de ejecutar la funcion model_basic(), todos los resultados se
encuentran almacenados en los objetos “result_pft” y “result_nft” Estos objetos son una lista
de 11 componentes. Podemos ver el contenido de la lista haciendo clic sobre el nombre del
objeto (ver Figura 39) o ver la estructura de la lista haciendo clic sobre la flecha ( ¢

Figura 39. Estructura de los resultados de un modelo DEA basico.

Q_:IE Edit Code View Plots Session Build Debug Profile Tools Help
@ | gjempla_basicR
Show Attributes
Name Type Value
@ result_nft list [11] (S3: dea)
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© dmu_ref integer [21]
vitrans_i NULL
virans_o NULL
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rts="crs")
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Para extraer los resultados del analisis DEA, deaR cuenta con una serie de funciones
especificas. Estas funciones son:

v’ efficiencies(): Extrae las puntuaciones de eficiencia.

slacks(): Extrae las holguras.

targets(): Extrae los valores objetivo (targets).

lambdas(): Extrae las intensidades o lambdas.

references(): Extrae el conjunto de referencia de las DMUs ineficientes.

rts(): Extrae los rendimientos a escala que caracterizan a una DMU.

RN N N NN

multipliers(): Extrae los multiplicadores (o pesos) del modelo DEA en forma
multiplicativa.

En el Ejemplo 11 vamos a practicar con estas funciones.

ST« ER Extraccion de resultados.

Para extraer las puntuaciones de eficiencia de “result_pft”, que contiene los resultados del
modelo DEA CCR input-orientado para las DMUs en PFT, solo tenemos que escribir la
instruccion:

efficiencies(result_pft)
y ejecutarla.

Las puntuaciones de eficiencia se mostrardn en la Consola, como puede verse en la siguiente
Figura.

Figura 40. Eficiencia DMUs en PFT.
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Sitel site) &ite3 sited Sites Siteb site/  site8 = Naime size Modified
1.00000 0.90169 0.98827 0.90244 1.00000 0.90689 0.89236 0.91476 T 2
Site9 5iteld sSitell Sitel2 S5itel3 Siteld Sitel5 Sitel6 @] RData 28 KB Nov 2, 2018, 11:09 AM
0.87109 1.00000 0.98194 0.97444 0.85996 0.98397 1.00000 0.95030 - i
Sitel7 Sitel8 Sitel9 Site20 Site2l Site22 Site23 Site24 "] Rhistory 29KB Mov 4, 2018, 10:52 AM
11 90000 10 90000 0. ?5010 i 90000 i I 0_0000 i b 90000 0. ?6300 1 1 90000 | Coll_Blasco_2006.xlsx 84 KB Oct 14, 2018, 2:02 PM
Site?25 S5ite26 Site?/ S5ite28 Site29 Site30 Site3l Site32 @) ejemplo_read_dataR 678 Nov 2, 2018, 552 PM

0.97644 0.93714 1.00000 0.94433 0.84171 0.90255 0.83922 0.90698
site33 site34 site35 sSite36 Site37 sSite38 site39 sitedo 9 gjemplo_read_data_fuzzyR 0B Nov 2, 2018, 8:22 PM

0.94022 0.85206 1.00000 0.80318 0.86141 0.97015 0.93515 1.00000 ') cjemplo_read_data_malmquistR 2018 Nov 2. 2018, 7-43 PM
Sitedl Sited2 Sited3 sSitedd Sited5 Sited6 Sited7 Sited8 i ¥ '
0.94682 0.94735 0.87076 1.00000 0.89159 0.90873 1.00000 1.00000 %/ Paper_1.Rproj 2188 Nov 4, 2018, 10:48 AM
sited9 O sesion_1R 478 Nov 1,2018, 11:26 AM
1.00000 @ i
- * | sesion_2.R 1578 Nov 2, 2018, 11:28 AM

L @ | ciamnla hacicR 7a1R N d 2018 11146 AM Y

De forma similar, para extraer los conjuntos de referencia escribimos y ejecutamos la
instruccion:
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references(result_pft)

El resto de funciones (slacks(), targets(), lambdas(), rts() y multipliers()) se utilizan de forma
similar. Observad los resultados que se extraen.

7.5. Resumen de resultados. La funcién summary().

Ademas de las funciones anteriores (efficiencies(), lambdas(), etc.), deaR cuenta con la
funcién summary(), que resume los resultados del andlisis DEA. La funcidn summary() sirve
para resumir los resultados tanto de los modelos DEA convencionales como de los modelos
DEA fuzzy. Para utilizar esta funcidn tenemos que saber que tiene la siguiente estructura®®:

summary(objeto, exportExcel = TRUE, filename = NULL)

Los argumentos de esta funcién se refieren a:

e object: Es el objeto en al que hemos asignado los resultados de un modelo DEA
convencional o DEA fuzzy.

e exportExcel: El valor por defecto para este argumento es TRUE. Por tanto, la funciéon
resumen automaticamente creara un fichero Excel con los principales resultados en
el directorio de trabajo. El usuario puede elegir no crear el fichero Excel de resumen
de resultados (exportExcel= FALSE).

e filename: Por defecto, el valor del argumento es NULL. Por tanto, el nombre por
defecto del fichero Excel serd: “ResutsDEAafio-mes-dia_hora:minuto:segundo.xlsx”.
Por supuesto, el usuario puede dar nombre al fichero Excel.

Como hemos comentado, la forma de utilizar la funcion summary() para resumir los
resultados de una analisis DEA es idéntica tanto en los modelos DEA convencionales como
los modelos DEA fuzzy. La diferencia se encuentra en el fichero Excel que se genera en el
resumen. Es decir, las hojas Excel que se crean son distintas seglin el modelo. Vamos a ver
esto en los Ejemplos 12 y 13.

Resumen de resultados: modelo DEA convencional.
Seguir los siguientes pasos:

1. Abrir el proyecto “Paper_1".

2. Crear un nuevo script: “Resumen_DEA”

3. Cargar deaR.

Supuesto: Cargar el dataset de deaR: “Hua_Bian_2007"%°. Este dataset tiene 30 DMUs con,
por este orden, 2 inputs (D-Inputl, D-Input2), 2 outputs (D-Outputl, D-Output2) y 1 output
no deseable (UD-Outputl).

19 podemos utilizar la ayuda de deaR: help(summary.dea) o help(summary.dea_fuzzy).

20 Hya Z.; Bian Y. (2007). DEA with Undesirable Factors. In: Zhu J., Cook W.D. (eds) Modeling Data Irregularities
and Structural Complexities in Data Envelopment Analysis. Springer, Boston, MA. https://doi.org/10.1007/978-
0-387-71607-7 6
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Queremos obtener el resumen de resultados del modelo BCC output-orientado. Como hay
un output no deseable, para tenerlo en cuenta en el anadlisis utilizaremos como vector de
traslacion el utilizado por Hua y Bian (2007): vtrans_o=1500.

Importante: Recuerda los pasos para utilizar deaR.

Paso 1. Cargar los datos.

Paso 2. Adaptar los datos al formato de lectura de deaR.

Paso 3. Ejecutar el modelo DEA.

Paso 4. Extraer los resultados.

Intentadlo!!!

(la solucion en la siguiente pagina)
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escribir en el script “Resumen_DEA” las siguientes instrucciones:

Paso 1. Cargar los datos:

Pas 2. Adaptar los datos:

Paso 3. Ejecutamos el modelo DEA

data(“Hua_Bian_2007")

data_ejemplo_12 <- read_data(Hua_Bian_2007,

ni=2,
no=3,

ud_output=3)

Observacion: Tenemos 3 outputs (no=3) y el tercer output
es el output no deseable (ud_output=3)

resultado_ejemplo_12 <- model_basic(data_ejemplo_12,
orientation="00",
rts="vrs”,

vtrans_o= 1500)

Figura 41. Solucién Ejemplo 12.

dR

Solucidn: Como podemos ver en la Figura 41, para resolver el Ejemplo 12 tenemos que

@ RStudio File Edit Code View Plots Session Build Debug Profile Tools Window Help

& D

= o) 100% B3

Séb17 nov 12114 Vicente Q =

e0e
LR SR - Addins -
Source on Save i 3 =+ Run
1 library(deaR)
2
3 |# PASO 1. CARGAR DATOS:
4 Qdata( "Hua_Bian_2007")
3
6 J# PASO Z: ADAPTAR DATOS:
7 [data_ejemplo_12 <- read_data(Hua_Bian_z2@@7,
8 ni=2,
9 no=3,
12 ud_output=3)
11

-
-
-

"
-
"

12 j# PASO 3: EJECUTAR EL MODELO DEA:

13 §resultado_ejemplo_1Z <- model_basic(data_ejemplo_12,

14 orientation="o0",
15 rts="vrs",

16 vtrans_o= 1500)
il

18

17:1 | (Top Level) =

Console ~/Deskio

yp/Paperl
# PASO 1. CARGAR DATOS:

data("Hua_Bian_z@e7"}
# PASO 2: ADAPTAR DATOS:
data_ejemplo_12 <- read_data(Hua_Bian_2007,
ni=2,
no=3,
ud_output=3)
# PASO 3: EJECUTAR EL MODELO DEA:
resultado_ejemplo_12 <- model_basic(data_ejemplo_12,
orientation="00",
rts="vrs",
vtrans_o= 15€e)

RE2

~/Desktop/Paper1 - RStudio

=0

Source -

RScript =

=0

Environment  History  Connections.

> “ import Dataset ~ &

"% Global Environment ~

Data

O data_ejemplo_12
Hua_Bian_zee7

List of 9
3@ obs. of 6 variables

resultado_ejemplo_12 List of 11

Files Plots Packages

©  NewFolder @ Delete = Rename

Help  Viewer

{3 More ~

£2) Home ~ Desktop = Paperl

A Name
t.
@ RData
“| .Rhistory

Coll_Blasco_2006.xIsx

ejemplo_basic.R

@
@ ejemplo_read_data.R
@
)

ejemplo_read_data_fuzzy.R

ejemplo_read_data_malmquist.R

% Paper_1.Rproj

@) Resumen_DEA.R

@7 sesion_LR
@) sesion_2.R

Size

2.8KB
8KB
8.4 KB
844 8
126 B
o8
3018
2058
485 B
478
157 B

& Paperl -
=0

List
=Y

Modified

Nov 2, 2018, 11:09 AM
Nov 17, 2018, 12:13 PM
Oct 14, 2018, 2:02 PM
Nov 4, 2018, 12:04 PM
Nov 11, 2018, 11:30 AM
Nov 2, 2018, 8:22 PM
Nov 8, 2018, 5:06 PM
Nov 17, 2018, 12:13 PM
Nov 17, 2018, 12:13 PM
Nov 1, 2018, 11:26 AM
Nov 2, 2018, 11:28 AM

Todos los resultados del modelo BCC output orientado que hemos ejecutado se encuentran
en el objeto “resultado_ejemplo_12", que es una lista de 11 componentes (ver Figura 42).
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Figura 42. Estrucutrua “resultado_ejemplo_12".

@ RStudio File Edit Code View Plots Session Build Debug Profile Tools Window Help B <0 = W) 100%[EA Sib17nov 12115 Vicente Q =
[ XoN ] ~[Desktop/Paper1 - RStudio
e - o o~ ~ Addins = & Paperl ~
© | Resumen_DEAR [  Environment History Connections =0
sourceonsave 4/ - +Run | % Source " d # Import Dataset + | & List +
1 library(deaR) "} Global Environment +
a2
3 # PASO 1. CARGAR DATOS: Dt O
4 data("Hua_Bian_2007") data_ejemplo_12 List of 9
5 i variables
Bg ® PASQ Z: ADAPTAR DATOS: . © resultado_ejemplo_1Z List of
7 date_cjenplo 12 < read_catoHua Bion 2007, e
ni=z,
9 no=3 orientation: chr "o0o"
10 ud_output=3) rts @ chr "wrs”
11 L:numl
12 # PASO 3: EJECUTAR EL MODELO DEA: U:onum 1
13 resultado_ejemplo_12 <- mndel,mslC(aata,ejer!zpln,lz,_ DMU :List of 30
g DRl MEaLLon=000.5 ..$ DMUL :List of 8
15 rts="vrs",
16 virans_o- 1500) ..$ efficiency @ num 1
17 ..$ lambda : Named num [1:32] 10 @000 Q@@@0Q ...
18 ..- attr(*, "names")= chr [1:3g] "DMUL" "DMU2" "DMU3" "DMU4" ...
..$ slack_input : Named num [1:2] @ @
..- attr(*, "names")= chr [1:2] "D-Inputl" "D-Input2"
A7 TR CTOp L avai RScopri ..$ slack_output : Named num [1:3] @ @ @
(o per1 =0 ..- attr(*, "names")= chr [1:3] "D-Outputl” "D-OutputZ” "UD-Outputl®
> # PASO 1. CARGAR DATOS: Files Plots Packages Help Viewer =
> data("Hua_Bian_2007") -
s % PASO 2: ADAPTAR DATOS: ' NewFolder | @ Delete = Rename = {3k More ~
> data_ejemplo_12 <- read_data(Hua_Bian_2007, 4 Home - Desktop - Paperl S
+ ni=z, A Name size Modified
+ no=3, t.
+ ud_output=3) po
> # PASO 3: EJECUTAR EL MODELO DEA: -RData 2.8 k8B Nov 2, 2018, 11:09 AM
> resultado_ejemplo_12 <- model_basic(data_ejemplo_12, .Rhistory 8 KB Nov 17, 2018, 12:13 PM
+ orientation="00", Coll_Blasco_2006.xIsx 8.4 KB Oct 14, 2018, 2:02 PM
+ rts="vrs", &
i virans_o= 1500) ejemplo_basicR 8448 Nov 4, 2018, 12:04 PM
> @] ejemplo_read_data.R 1268 Nov 11, 2018, 11:30 AM
@] ejemplo_read_data_fuzzy.R 0B Nov 2, 2018, 8:22 PM
@] ejemplo_read_data_malmaquist.R 3018 Nov 8, 2018, 5:06 PM

En este punto, podemos extraer los resultados parciales con las funciones: efficiencies(),
lambdas(), multipliers(), rts(), references(), slacks(), targets(); y el resumen de resultados con

la funcién summary().

Como se muestra en la Figura 43, extraemos las puntuaciones de eficiencia de las DMUs con
la funcion efficiencies(). Las eficiencias son mostradas en la Consola y asignadas al objeto
“eff’. Para obtener los mismos resultados que los mostrados por Hua y Bian (2007),

escribimos en el script:

y ejecutamos la instruccion.

Figura 43. Puntuaciones eficiencia.

1/eff

@ RStudio File Edit Code View Plots Session Build Debug Profle Tools Window Help B O 2 W) 100% @A Sib17nov 13:18 Vicente Q =
[ XoN ] ~[Desktop/Paper? - RStudio
e - O > - + Addins - Rl Paperl ~
©| Resumen_DEA.R —["]  Environment History Connections ]
Source on Save = 4 - =Run | "= Source - > # Import Dataset ~ & List =
4 data("Hua_Bian_2007") "k Global Envirenment =
B Data
6 # PASO 2: ADAPTAR DATOS: e i 7
7 data_ejemplo_lZ <- read_data(Hua_Bian_20@7, ta_ejemplo_ 1500
8 ni=2 Hua_Bian_Z@87 30 obs. of & variables
9 no=3, resultado_ejemplo_12 List of 11
10 ud_output=3) Values
e IMamaa num [1:30] 1 1 1.18 1.87 1 ... I
1z # PASO 3: EJECUTAR EL MODELO DEA:
13 resultado_ejemplo_1Z <- model_basic(data_ejemplo_12,
14 orientation="00",
15 rts="vrs",
16 vtrans_o= 1508)
17
18 [# PASO 4. EXTRAER LOS RESULTADOS: Filas | Plots | Packages | Help | Viewsr -0
19 fleff <- eff ltado_ejemplo_12 .
5 :fF e e @ | New Folder | © Delete =|Rename | {3} Mare ~
21 Jireff # resultados M5 en tabla 6-5 (p. 119) /) Home . Desktop . Paperl S
77 A Name Size Modified
23:1  (Top Level) * R Script &
£ -
Console ~/Desktop/Paperl =0 @) RData 2.8 KB Nov 2, 2018, 11:09 AM
> eff Rhistary 8.8 KB Nov 17, 2018, 1:00 PM
DMUL  DMUZ  DMU3  DMU4  DMUS  DMUB  DMU7  DMUS  DMU9  DMU@

1.00000 1.00000 1.17726 1.06856 1.0@080 1.80080 1.81357 1.25406 1.56036 1.90000 e ks B A
DMULL DMU1Z DMU13 DMU14 DMUIS DMUI6 DMUL7  DMULS DMUL®  DMUZ@ @ ejemplo_basic.R 8448 Nov 4, 2018, 12:04 PM
1.25912 1.90000 1.00274 1.00000 1.00000 1.05394 1.00000 1.85749 1.62927 1.00000 9 ejemplo_read_data.R 1268 Nov 11, 2018, 11:30 AM
DMUZL DMUZZ DMU23  DMUz4 DMU25 DMUZ6 DMU27  DMUZ8  DMU23  DMU3@ # F R - o R

1.14443 1.08000 1.00000 2.12814 1.26370 1.00000 1.00000 1.00798 1.00008 1.08000 slemplo_reac data fuzzy Ot -
> l/eff # resultados M5 en tabla 6-5 (p. @ ejemplo_read_data_malmguist.R 3018 Nov 8, 2018, 5:06 PM
OMUL oMUz OMU3 OMU4 DMUS DMUG d DMUB © Paper_1.Rproj 2058 Nov 17, 2018, 1:17 PM
1.0000000 1.0000000 ©.8494300 ©.3358389 1.0000000 1.0000000 ©.98366117 0.7974100 o :
M9 MU0 DMULL DMU12 DMU13 DMUL4 DMULS MUL6 ResultsDEA2018-11-17_12:35:11.xlsx 14.9 KB Nov 17, 2018, 12:35 PM
©.6408777 1.0000000 ©.7342055 1.0000000 0.9972675 1.0000000 1.0008000 ©.9434436 9 Resumen_DEA.R 668 B Nov 17, 2018, 1:17 PM
DMUL7 DMUL8 DMUL9 DMUZ0 DMUZ1 DMUZZ oMUZ3 DMUZ4 W sision LR e N T 0T8T 76 AN
1.0000000 ©.9456354 ©.6137718 1.0000000 ©.8738203 1.0000000 1.0000000 ©.4698939 by ' '
IMUZ5 OMUZE oMUZ7 DMUZE oMUZ3 MU0 9 sesion_2.R 1578 Nov 2, 2018, 11:28 AM
©.7913271 1.2000000 1.8000000 ©.9920832 1.0000000 1.0000000
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summary(resultado_ejemplo_12)

dR

Para obtener un resumen de todos los resultados obtenidos al ejecutar el modelo DEA BCC
output-orientado utilizamos la funcién summary(). Escribimos en el script “Resumen_DEA”:

Todos los resultados son mostrados en la Consola. Aunque no hay muchas DMUs (solo 30),
hay muchos resultados. No es practico utilizar la funcién summary() para ver los resultados
en la pantalla. Sin embargo, como podemos ver en la Figura 44, deaR ha creado un fichero
Excel que tiene todos estos resultados. Observad el nombre que por defecto se ha dado al

fichero.

Figura 44. Resumen resultados ejemplo 12.

@ RStudio File Edit Code View Plots Session Build Debug Profle Tools Window Help [ O = o) 100% B Sab17 nov 13118 Vicente Q =

0@
Q - 0p |-

© | Resumen_DEAR

SourceonSave | O /- =Run

8 ni=2,

9 no=3,

10 ud_output=3)

11

1z # PASO 3: EJECUTAR EL MODELO DEA:

13 resultado_ejemplo_1Z <- model_basic(data_ejemplo_12Z,

14 orientation="o00",

15 rts="vrs",

16 vtrans_o= 1500)

17

18 # PASO 4. EXTRAER LOS RESULTADOS:

19 eff <- efficiencies(resultado_ejemplo_12)

20 eff

21  1/eff # resultados M5 en tabla 6-5 (p. 119)

22

Z3 §# RESUMEN DE RESULTADOS

24

25 j sumary(resultado_ejemplo_12)

26 &

26:1 | (Top Level) =

Console ~/Deskic
6 2.0000 ©.0000 ©.0000 1.0000
7 0.0002 ©.0000 0.0000 0.9578
8 ©.0000 ©.0000 0.0000 0.2696
o 0.8455 ©.0000 0.0000 ©0.0000
e ©0.0000 0. 0000 0.0000 ©0.9000
11 ©0.0000 ©.0000 ©.0000 8.9722
12 8.0000 0.0000 0.0000 0.9000
13 8.2558 0.0000 0.0000 0.9000
14 0.0000 0.0000 0.0000 0.9000
15 @.0000 0.0000 0.0000 0.9000
16 2.0000 ©.0000 ©.0000 2.0000
7 2.0000 0.0000 ©.0000 8.0000

reached aetoetiuns"max.pmnt") -- omitted 13 rows ]

Warning message:
In rts(object) :

rts function with variable returns teo scale does not make much sense!

>

=0

RScript

=0

~/Desktop/Paper1 - RStudio

Environment  History ~ Connections
ol # Import Dataset ~ &

"% Global Environment +

Data
data_ejemplo_12
Hua_Bian_2@e7
resultado_ejemplo_12 List of 11

Values

List of 9
3@ obs. of 6 variables

eff Named num [1:36] 1 1 1.18 1.87 1 ...

Files Plots Packages Help Viewer
©  NewFolder © Delete - Rename {3 More ~

42} Home - Desktop - Paperl

A Name Size
k..
@ RData 2.8 KB
“ .Rhistory 8.8 KB
Coll_Blasco_2006.xIsx 8.4 KB
@ ejemplo_basic.R 844 B
@ ejemplo_read_data.R 126 B
@ ejemplo_read_data_fuzzy.R 0B
@ ejemplo_read_data_malmquist.R 3018B
R Paper_l.Rproj 205B
ResultsDEA2018-11-17_12:35:11.xIsx 14.9 KB
@ Resumen_DEA.R 668 B
9 sesion_LR 47 B
9 sesion_2.R 157 B
| ResultsDEAZ018-11-17_13:18:29.x1sx | 14.9 KB

& Paperl -
=Y

List ~
=

Modified

Nov 2, 2018, 11:09 AM
Nov 17, 2018, 1:00 PM
Oct 14, 2018, 2:02 PM
Nov 4, 2018, 12:04 PM
Nov 11, 2018, 11:30 AM
Nov 2, 2018, 8:22 PM
Nov 8, 2018, 5:06 PM
Nov 17, 2018, 1:17 PM
Nov 17, 2018, 12:35 PM
Nov 17, 2018, 1:17 PM
Nov 1, 2018, 11:26 AM
Nov 2, 2018, 11:28 AM
Nov 17, 2018, 1:18 PM

Abrir el fichero Excel para ver cdmo se ofrecen los resultados (ver Figura 45). Para ello,

hacemos clic sobre el

fichero

seleccionamos la opcion “View file”.
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drR

Figura 45. Excel con resumen de resultados.
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e 'I efficiencies | slacks | lambdas | targets | rewms J relerencesJ+} [
=

117726
1,06856
1
1
1,01357
1,25406
156036
1
125812
1
1,00274
1
1
1,05994
1

1,05749
162927

1
11484
1

1
212814
1,2637
1

1
1,00798
1

1

Vista normal

Suma=0 - i

Guardamos el script “Resumen_DEA".

Ahora, en el Ejemplo 13 vamos a replicar los resultados de Ledn, et al. (2003)%.

I11]: ][ ER Resumen de resultados: modelo DEA fuzzy.

Ledn et al. (2013) utilizan técnicas de programacién posibilistica para medir la eficiencia
basada en la forma envolvente del modelo BCC input-orientado. Los autores utilizados por
los autores en su articulo se encuentran en el dataset “Leon2003”, que sumistrado con

deaR.

Creamos un nuevo script: “Resumen_DEA fuzzy”. Para replicar los resultados que los
autores muestran en la Tabla 2 (pagina 419), escribimos en el script:

data("Leon2003")

data_example <- read_data_fuzzy(Leon2003,
dmus=1,
inputs.mL = 2,
inputs.dL =3,
outputs.mL =4,
outputs.dL = 5)

result <- modelfuzzy_possibilistic(data_example,
h=seq(0, 1, by = 0.1),
orientation = "io",
rts = "vrs"
efficiencies(result)

21 |éon, T.; Liern, V. Ruiz, J.; Sirvent, I. (2003). "A Possibilistic Programming Approach to the Assessment of
Efficiency with DEA Models", Fuzzy Sets and Systems, 139, 407-419. https://doi.org/10.1016/S0165-

0114(02)00608-5
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Nota: h=seq(0, 1, by=0.1) genera una secuencia de valores
para los diferentes niveles de posibilidad: h=(0, 0.1, 0.2,...,1).

ejecutamos las instrucciones. En la Consola (ver Figura 46) se mostrardn las puntuaciones de
eficiencia del modelo BCC input-orientado para los distintos niveles de posibilidad h.

Figura 46. Puntuaciones de eficiencia para distintos niveles de posibilidad.

# RStudio File Edit Code View Plots Session Build Debug Profile Tools Window Help [ <D = o) 86%@EF Lun19nov 2:23 Vicente Q =
[ ] [ ] ~{Desktop/Paper1 - RStudie
o - g i + Addins + % Paperl -
—[7  Environment History Connections =
ree onSave | O - *Run | "= Source ~ - # Import Dataset = | & List ~
1 library(deaR) % Global Environment +
z
e
3 | dataC"Leonzees") =
4 | data_example <- read_data_fuzzy(Leon20@3, data_example List of 9
5 dmus = 1, Leonz@e3 8 obs. of 5 variables
6 inputs.ml = 2, result List of 10
7 inputs.dL = 3,
8 outputs.mL = 4,
9 outputs.dL = 5)
1@
11 | result <- modelfuzzy_possibilistic(data_example,
12 h = seq(@, 1, by = 0.1),
13 orientation = "io",
14 rts = "vrs") Files Plots Packages Help \Viewer =
15 Jefficiencies(result) -
i © NewFolder © Delete = Rename {3 More -
£ Home = Desktop = Paperl R
16:1 (Top Level) = R Script 4 Name Size Modified
E .
Console =0
] :
i e .RData 2.5 K8 Nov 17, 2018, 1:18 PM
> result <- modelfuzzy_possibilistic(data_example, .Rhistory 9.8 KB Nov 17, 2018, 8:17 PM
+ alpha= seq(@, 1, by = @.1}, Coll_Blasco_2006.xIsx 8.4 KB Oct 14, 2018, 2:02 PM
+ orientation = "io", & .
& rts = "wrs"y ejemplo_basic.R 8448 Nov 4, 2018, 12:04 PM
> efficiencies(result) @ ejemplo_read_data.R 1268 Nov 11, 2018, 11:30 AM
e 0.1 0.2 0.3 0.4 0.5 8.6 0.7 8.8 0.3 1 @ ejemplo_read_data_fuzzy.R 08 Nov 2, 2018, 8:22 PM
A 1.00000 1.00080 1.90000 1.00000 1.00008 1.08000 1.80000 1.08000 1.00000 1.00000 1.80000 5
B 1.90800 1.00000 1.00000 1.80000 ©.97674 0.94118 .90476 ©.86747 ©.82927 .79012 ©.75000 sjemplo_read_data_malmquist.R Ak Pow B, 2015, 5:06 P
C 1.00000 1.00000 1.00000 1.00000 1.90000 1.09000 1.00000 1.00000 1.00000 1.00000 1.90800 & Paper_1.Rproj 2058 Nov 19, 2018, 2:20 AM
D ©.75000 ©.73957 ©.72919 0.79809 0.68529 0.66204 ©.638331 @.61410 ©.58939 8.56413 ©.53846 @) Resumen DEAR e Nov 17, 2018, 1:17 PM
E 0.64286 0.63977 ©.63688 0.63105 0.62439 0.61719 ©.68940 0.60099 ©.53189 ©.58206 0.57143 6
F ©.60504 ©.59527 ©.58571 0.56597 ©.54458 0.52273 8.50041 0.47761 8.45432 0.43054 0.40625 sesion_L.R 47H Nov-1, 2015, 11:26 AM
G 1.00000 1.00000 1.00000 1.00000 1.00000 1.00000 1.00@00 1.00000 1.00000 1.00000 @.4500@ @ | sesion 2.R 1578 Nov 2, 2018, 11:28 AM
H @.69231 ©.68992 ©.6875@ 0.68504 0.66667 0.64000 ©.61290 @.58537 ©.55738 ©.52893 0.5000@ I @ Resumen_DEA_fuzzy.R I 5498 Nov 19, 2018, 2:23 AM

Para obtener un resumen de resultados en pantalla (ver Figura 47) y exportarlos a un fichero
Excel escribimos la siguiente instruccion en el script y la ejecutamos:

Figura 47. Resumen del modelo posibilistico BCC input-orientado.
@ RStudio File Edit Code View Plots Session Build Debug Profle Tools Window Help B D Z o) 86%@E Luni9nov 2:24 Vicente Q =
[ XN ) ~[Desktop/Paper1 - RStudio
e -y i - Addins - R paperl -
@ | Resumen_DEA_fuzzy.R* (7]  Environment History Connections =
Source on Save | 4/ - +Run | % Source ~ > # Import Dataset ~ & List -
3 dataC"Leon2063") 7% Global Environment +
4 data_example <- read_data_fuzzy(Leon2@03, Data
3 S =il data_example List of @
6 inputs.mL = 2, .
7 inputs.dL = 3 Leonzoe3 8 obs. of 5 variables
B8 outputs.mL = 4, result List of 10
9 outputs.dL = 5)
1@
11 result <- modelfuzzy_possibilistic(data_example,
12 h = seq(®, 1, by = 0.1),
13 orientation = "io",
14 rts = "vrs")
Files Plots Packages Help Viewer =l

15 efficiencies(result)
New Folder | @ Delete = Rename {3 More -

16 [+]
g /A Home - Desktop - Paperl R
Size Modified

19 A Name
19:1  (Top Level) R Script : L .
T = @ RData 2.5KB Nov 17, 2018, 1:18 PM
Prg 0.0 070012 1.0000 6.0000 0.0000 000 00| ] .Rhistory 9.8 KB Nov 17, 2018, 8:17 PM
s C . . Coll_Blasco_2006.xIsx 8.4 KB Oct 14, 2018, 2:02 PM
;? E 9 ejemplo_basic.R 844 B Nov 4, 2018, 12:04 PM
s F 9 ejemplo_read_data.R 126 B Nov 11, 2018, 11:30 AM
S 9 ejemplo_read_data_fuzzy.R 0B Nov 2, 2018, 8:22 PM
:2 : ¢ ejemplo_read_data_malmquist.R 3018 Nov 8, 2018, 5:06 PM
k2 8 . Paper_1.Rproj 205 B Nov 19, 2018, 2:20 AM
B3 C @] Resumen_DEA.R 668 B Nov 17, 2018, 1:17 PM
:: E @ sesion_1.R 47 B Nov 1, 2018, 11:26 AM
Be  F @] sesion_2.R 1578 Nov 2, 2018, 11:28 AM
p7 G © | Resumen DEA fuzzy.R 5498 Nov 19, 2018, 2:23 AM
L I ResultsDEA2018-11-19_02:24:22.xlsx I 8.2 KB Nov 19, 2018, 2:24 AM
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En el modelo posibilistico el resumen de resultados consta de: (1) las puntuaciones de
eficiencia y (2) los conjuntos de referencia. Estos son los resultados que se exportan al libro
de Excel (ver Figura 48).

Figura 48. Resultados del modelo en Excel.

@ Excel Archivo Edicién Ver Insertar Formato Herrang da 33 Ch 0 = W) 83% M) Lun19nov 2:32 Vicente Q =
ece I“ ResultsDEAZ018-11-19_02/31/36.xIsx (Sélo Iectura)l
; . H A — -
DEOE® XDE& 00 E-f B @0 8 o © @& )
A Inicio ! Disefio Tablas | Graficos | SmartArt | Férmulas | Datos | Revisar | ~ TEr
Eaitar Fuente Alineacion : Nimera Formato Celgss Temes
=, [#] Rettenar - [caliori (Cuerpo) [=[11 [~]||As| A~| | = == B8 aber | 559 Austar texto ~ - |General - [Hormal ] % = @:ﬂ. Ffle : [Aad. BET:
: : B o assa :
regar (ARomar - QY C| S| |HE~ _(& M A MHEE EINERE combinar - : B v % 0w ¢ﬁ: e} C‘;g‘,’,,f;g“ i " | nsertar Eliminar Formato | Temas  Aav
Al i & fx DMU |-
A I I p [ [ F ¢ [ H [ | [ J [ kK | L | M | N [ O [ P [ @ [ R [ § [T T [ uwu [ ~ [ w |
| 1 u A B 4 D E F G H 4
2 0 1 T [ 0 0 0 0 a 0
3 0 1 0 1 [ 0 0 0 0 [
4 0 1 a [ 1 0 0 0 [] [
5 [ 0,75 [ 05 05 0 [ [ [] [
6 0 064286 0 01429 08571 [ [ [ a [
7 0 060504 0 05714 04286 [ [ [ [ 0
| 0 1 a [ a 0 o 0 1 a
o 0 069231 [ 1 ] [ 0 0 [] [
10 01 1 1 [] [ 0 0 0 0 []
] 01 1 a 1 a 0 0 0 ] [
iF2 01 1 0 [] 1 0 0 0 ] []
[EER 01 073957 0/ 05071 04929 [ [ [ a [
14 01 063977 0 01571 08429 0 [] [ [] 0
15 01 058527 0| 05857 04143 [ [ [ [ a
16 | 01 1 [} [ [ 0 [ [ 1 o
[iEA 01 0685952 [ 1 a 0 o o a [
18 02 1 1 [ o 0 0 0 a [
19 032 1 0 1 [ 0 0 0 0 [
20 02 1 a a 1 0 [ 0 [] [
21 02 072919 0 05143 04857 0 [ [ [] ]
22 02 063688 0 01714 0,828 [ [ [ a [
23 02 058571 [} 06 04 [ [ [ [ 0
24 02 1 a a a 0 0 o 1 a
25 02 08875 [} 1 0 0 [ 0 [] [
26 03 1 1 a a [ o o a [
27] 03 1 a 1 a 0 0 0 ] [
28 03 1 0 [] 1 0 0 0 0 []
29 03 070809  0,6083 o/ 03917 [ [ [ a [
30 03 063105 02167 0 07833 0 [] [ [] 0
31 | 03 056587  0,7167 0 072833 [ [ [ [ [
32 | 03 1 [} [ [ 0 [ 0 1 o
B3 03 068504 a 1 a [ o 0 a a
34 04 1 1 [ o 0 0 0 a [
35 04 057674 1 [] [ 0 0 0 0 []
36 | 04 1 a a i 0 0 0 [] [
37 T:mm ? )r.m o __nama 2 o o n g
e
vista normal Listo Suma=0 >

Guardamos el script “Resumen_DEA fuzzy”.

7.6. Representaciones graficas. La funcion plot().

Con la funcidn plot() podemos obtener algunas representaciones graficas de los resultados
obtenidos al ejecutar un modelo DEA convencional, la eficiencia cruzada o el indice de
productividad de Malmquist. En los ejemplos 14, 15 y 16 se muestra cdmo obtener los
graficos de estos modelos.

La funcidn plot() se utiliza de la siguiente forma:
plot(x)
donde x es el objeto donde se almacenan los resultados de un modelo DEA.

Después de usar la funcién plot() el grafico aparecerd en el Viewer (ventana inferior
derecha). Podemos guardar un grafico haciendo clic en la pestafia Export del Viewer. Es
posible guardar un grafico como una imagen en formato: “png”, “jpeg” o “tiff’. También
podemos copiar el gréfico en el portapapeles y pegarlo, por ejemplo, en un document Word.

En esta version 1.0 no estan disponibles graficos para modelos DEA fuzzy.

Actualmente estamos trabajando para mejorar las salidas graficas de deaR, que seran
incorporadas en la proxima version.

3110« Plot: modelo DEA basico.

Abrimos el script “Resumen_DEA”. Si cerramos la sesidon de trabajo: abrimos el proyecto
“Paper_1", cargamos deaR y abrimos el script.
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Nuestra sesion de trabajo deberia ser similar a la que se muestra en la Figura 49.

Figura 49. Script “Resumen_DEA” .

#@ RStudio File Edit Code View Plots Session Build Debug Profile Tools Window Help [ +O = o) 40%M@) Dom25nov 13116 Vicente Q i=
[ XoN ] ~[Desktop/Paper_1 - RStudio
o .| 2+~ ~ Addins ~ R Paper_l — Desktop ~
© | Resumen_DEAR ~=["]  Environment History Connections e
Source on Save A, - +Run | >+ Source = 2 # Import Dataset v | & List =
1 library(deaR) 7} Global Environment =
2
3 # PASO 1. CARGAR DATOS:
4 data("Hua_Bian_2007") g K
5 Environment is empty
6 # PASO 2: ADAPTAR DATOS:
7 data_ejemple_12 <- read_data(Hua_Bian_2007,
ni-z,
9 no=3,
10 ud_output=3)
11

12 # PASDO 3: EJECUTAR EL MODELO DEA:

13 resultado_ejemplo_12 <- model_basic(data_ejemplo_12 Files Plots Packages Help Viewer P o |

L grientations © | NewFolder | © Delete = Rename {0k More «
5 rts="vrs",
16 vtrans_o= 1500) A& Home . Desktop  Paper_1 LS
17 4 Name Size Modified
18 # PASO 4. EXTRAER LOS RESULTADOS: L.
;Z :i; <~ efficiencies(resultado_ejemplo_12) @ RData 2.5 KB Nov 17, 2018, 1:18 PM
21 1/eff  # resultados MS en tabla 6-5 (p. 119) ] Rhistory 10 KB Nov 25, 2018, 1:15 PM
2z Coll_Blasco_2006.xIsx 8.4 KB Oct 14, 2018, 2:02 PM
Z3  # RESUMEN DE RESULTADOS
24 9 ejemplo_basic.R B44 B Nov 4, 2018, 12:04 PM
25 summary(resultade_ejemplo_12) @ ejemplo_read_data.R 1268 Nov 11, 2018, 11:30 AM
2 P ;
24:1 (Top Level) = R Script = @ ejemplo_read_data_fuzzy.R 08 Nov 2, 2018, 8:22 PM
@ ejemplo_read_data_malmguist.R 3018 Nov 8, 2018, 5:06 PM
Console =0
& Paper_l.Rproj 2058 Nov 25, 2018, 1:15 PM
Escriba ‘demo()" para demostraciones, 'help()' para el sistema on-line de ayuda, @ Resumen DEA.R 668 B Nov 17, 2018, 1:17 PM
o ‘help.start()" para abrir el sistema de ayuda HTML con su navegador.
Escriba 'q()’ para salir de R. 9 Resumen_DEA_fuzzy.R 567 8 Nov 19, 2018, 2:29 AM
@] sesion_LR 47 B Nov 1, 2018, 11:26 AM
[Workspace loaded from ~/Desktop/Paper_1/.RData] @) sesion_2.R 1578 Nov 2, 2018, 11:28 AM

>

Como se muestra en la Figura 50, seleccionamos desde la linea 1, library(deaR), hasta la
linea 16 y ejecutamos la seleccién. Inmediatamente, en el Environment se listaran tres
objetos: “data_ejemplo_12”, “Hua_Bian_2007" y “resultado_ejemplo_12".

Figura 50. Ejecutamos el script.

# RStudio File Edit Code View Plots Session Build Debug Profile Tools Window Help [ <0 “Z ) 40%@ ) Dom25nov 13:16 Vicente Q =
[ ] [ ] ~fDesktop/Paper_1 - RStudio
o .oy g~ ~ Addins - & Paper_l — Desktop ~
0| Resumen_DEAR [  Environment History Connections =
Source on Save R +Run | o+ Source * 2+ # Import Dataset + | & List =

1 |iibrarycdear) "k Global Environment =

Z

3 # PASO 1. CARGAR DATOS: ot

4 data("Hua_Bian_2007") data_ejemplo_12 List of 9

&

6 # PASD 2: ADAPTAR DATOS:

7 data_ejemplo_12 <- read_data(Hua_Bian_2007,

8 ni=2,

9 no=3,

1@ ud_output=3)

11

12 # PASO 3: EJECUTAR EL MODELO DEA:

13 resultado_ejemplo_1Z <- model_basic(data_ejemplo_1Z, Files Plots Packages Help Viewer P o |

i SEiRG L B G, ©  NewFolder € Delete = Rename = {JF More ~

15 rts="vrs" S

16 vtrans_o= 1500) W) Home = Desktop = Paper_1 R

iy A Name Size Modified

18 # PASO 4. EXTRAER LOS RESULTADOS: 1.

;: ::; <~ efficiencies(resultado_ejemplo_12) @) Rpata 2.5KB Nov 17, 2018, 1:18 PM

21 1/eff  # resultados M5 en tabla 6-5 (p. 119) -Rhistory 10 KB Nov 25, 2018, 1:15 PM

2z Coll_Blasco_2006.xlsx 8.4 KB Oct 14, 2018, 2:02 PM

23 # RESUMEN DE RESULTADOS

24 @ gjemplo_basic.R B44 B Nov 4, 2018, 12:04 PM

25 summary(resultado_ejemplo_12) @ ejemplo_read_data.R 126 B Nov 11, 2018, 11:30 AM

S TopLavel s RS s © | ejemplo_read_data_fuzzy.R 0B Nov 2, 2018, 8:22 PM

@ ejemplo_read_data_malmquist.R 3018 Nov 8, 2018, 5:06 PM
Console - /Desktop/Pape =0
" e % Paper_l.Rproj 205B Nov 25, 2018, 1:15 PM
& @ Resumen_DEA.R 668 B Nov 17, 2018, 1:17 PM
> # PASO 3: EJECUTAR EL MODELO DEA:
> resultado_ejemplo_12 <- model_basic(data_ejemplo_12, @ Resumen_DEA_fuzzy.R 5678 Nov 19, 2018, 2:29 AM
E orientation="00", @ sesion_1.R 478 Nov 1, 2018, 11:26 AM
+ rts="vrs"
) o 3

i vtrans_o= 1500) sesion_2.R 1578 Nov 2, 2018, 11:28 AM
5

Los resultados del modelo DEA estan almacenados en el objeto “resultado_ejemplo_12".
Para representar graficamente algunos de estos resultados vamos a escribir en la linea la 27
del script la siguiente instruccién:

plot(resultado_ejemplo_12)
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y la ejecutamos. En la Consola aparece el mensaje:

Press [enter] to continue

y en la pestafia Viewer (ventana inferior derecha) se mostrara un primer grafico de
resultados, como podemos ver en la Figura 51.

= W) 50% @} Lun26nov 16:52 Vicente Q =

Figura 51. Grafico 1 del ejemplo 12.
ﬂ' RStudio File Edit Code View Plots Session Build Debug Profile Tools Window Help [ {l)
~/Deskiop/Paper_1 - RStudio

e e
¢ .oyl - - Addins + # Paper_L — Deskiop -
©| graficos_ejemplo_12.R (7  Environment History Connections =0
Source on Save | O - +Run | "= Source ~ - # Import Dataset = | & List ~
U W PHOU Lo AUACTAN UATUS. P
7 data_ejemplo_12 <- read_data(Hua_Bian_2007, o
8 ni=2, Data
9 no-3, © data_ejemplo_12  List of 9
ﬁ i output=a) © Hua_Bian_2007 30 obs. of 6 variables
12 # PASO 3: EJECUTAR EL MODELO DEA: O resultado_ejemplo.. List of 11
13 resultado_ejemplo_12 <- model_basic(data_ejemplo_12, Values
14 orientation="00", eff Nomed num [1:3@] 1 1 1.18 1.7 1 ...
15 rts="vrs",
16 vtrans_o= 150@)

20 eff

17

18 # PASO 4. EXTRAER LOS RESULTADOS: i S | @

19 eff <- efficiencies(resultado_ejemplo_12) s % iz e =
@ = Export + | © & 45, Publish =

g; 1/eff  # resultados MS en tabla 6-5 (p. 119) EfficiermNon Efficient DMUs Non-efficient DMU distribution

23 # RESUMEN DE RESULTADOS B &4

24 12 14

25 summary(resultado_ejemplo_12)

26

27 Ip'Lﬂt(resulmdn_ejemp'lo_lz)I

28 44

29 10

30 € 5

31 =1 Q
S 5]

28:1 | (Top Level) * R Script =

Console ~/Deskiop/Paper_1/ =0 5 27

14 0.0000 8.0000

15 0.0000 8.0000

16 0.0000 0.0000 II I
12 5 18 21

17 0.0000 0.0000

reached getOption("max.print") -- omitted 13 rows ] N 0
> plot(resultado_ejemplo_12) Non-efficient Efficient 5
Press [enter] to continue Efficiency

En el grafico anterior se han representado el nimero de DMUs eficientes y no eficientes, asi
como la distribucién de la puntuacidn de eficiencia de las DMUs ineficientes. Si hacemos clic
en el botdn de Zoom se ampliara el grafico (ver Figura 52).

Figura 52. Zoom del Gréfico 1.

[ 3 File Edit Code View Plots Session Build Debug Profile Tools Window Help ] {D = o)) 50% @) Lun26nov 16:52 Vicente Q =
e - Oy .00 Elet Zoom, & Ppaper_1 — Desktop ~
Efficient/Non Efficient DMUs Non-efficient DMU distribution
@ graficos_| (=]
= 16 s List ~
7 datg
8 15
9
10 I
11 I
12 # P |
13 res| l
14 | 58
15 |
16
17 4
18 #pf 10
19 eff| =0
20 eff “% Publish -
= FE g icient DMU distribution
23 #RE 8 8 |
24
25  sum
26 |
27 plot 2
28 5
29
30
31
28:1 (T
Console ~
14
15
16
K : i
[ reached |
> plot(res Non-efficient Efficient 15, 15 18 21 15 1.8 21
Press [em:; Efficiency | Efficiency
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Al pulsar la tecla Enter aparecera el segundo grafico (ver Figura 53). En esta ocasidn se
representa el nimero de veces que una DMU eficiente forma parte del conjunto de
referencia de DMUs ineficientes.

Figura 53. Grafico 2 del ejemplo 12.

ﬂ' RStudio File Edit Code View Plots Session Build Debug Profile Tools Window Help [ {l) = W) 50%@E} Lun26nov 16:53 Vicente Q =
[ ] [ ] ~[Desktop/Paper_1 - RStudio
o - O - = Addins - # Ppaper_l — Desktop -
© | graficos_ejemplo_12.R —["  Environment History Connections — i
Source on Save | O - +Run | "= Source ~ - # Import Dataset = | & List ~
O PROU . AUAFTAR DATUD.
7 data_ejemplo_12 <- read_data(Hua_Bian_2007, "k Global Environment -
8 ni=2, Data
9 no=3, © data_ejemplo_12  List of 9
ﬁ doutput) © Hua_Bian_2007 38 obs. of 6 variables

12 # PASO 3: EJECUTAR EL MODELO DEA: / resultado_ejempl.. List of 11

13  resultado_ejemplo_12 <- model_basic(data_ejemplo_12, Values
14 orientation="00", eff Named num [1:30] 1 1 1.18 1.7 1 ...
15 rts="vrs",
16 vtrans_o= 150@)
17
18 # PASO 4. EXTRAER LOS RESULTADOS: = o — i @
19 eoff <- efficiencies(resultado_ejemplo_12) B Fots e L =0
20 eff M zoom | B Export+ QT § 4 Publish ~
21  Veff # resultados M5 en tabla 6-5 (p. 119) - = = = -
22 DMU3D : ! ! | 1
23 # RESUMEN DE RESULTADOS owuze [N
24 owuz71 - [
25 summary(resultade_ejemplo_12) DMUZE _4
Pl e ovuza| [
plot(resultado_ejemplo_ G
28 g owvz: 2
29 = ovuzo
30 Sowui7{ [
31 sovuis [
28:1 | (Top Level) = Rscripr = 2 pyuia{ [
0 049
Console ~/Desktop/Paper_1/ —r owuizy [
o i s omuio] [
15 0.0000 0. 0000
DMUB
16 0.0000 0. 0000 -
DMus< |0
17 0.0000 0.0000 ] o
o t") -- omitted 13 rows ] et
> plot(resultado_ejemplo_12) DMU1 ‘D

3 6 9

Press [enter] to continue
# times appearing in reference sets

Press [enter] to continue

Por ultimo, al pulsar nuevamente la tecla Enter se visualiza el ultimo grafico (ver Figura 54).

Figura 54. Gréfico 3 del ejemplo 12.

® RsStudio File Edit Code View Plots Session Build Debug Profle Tools Window Help [ <O = o) 48% @) Lun26nov 16:57 Vicente Q =
e0ce Plot Zoom
© -%m g 1 Paper_1 — Desktop =
@ plot_exam =
List ~

19

11

1z % sl

13 resu]

DX
14
i pAiDI2 offds

- DD+ s

18 # 5Tl
19 eff |
Dy @7
.9. S D@4 o>
5 DN@!! D@ | =0

20 eff ;
21 i/eﬂ D‘.D D@

23 # SUN

24 “%- Publish =
25 summ @7 g DM iy o

26
27 plot| NI o2

27:24 | (Teg
Console ~f|:: D:'Z‘) Dl.gw.lli;r.?PM DE..’»()

J6
9 DS
2 e D@ ;j%u

B1.e71 ...

12 r|
.;_ 2HMaul

13 D 3 D27 :

1 I.ﬁ ‘.sz—ﬁ

15 24PMBI30

16 129

17 i)27 29

[ reached

>
> plot(resy
Press [ente
Press [ente
>

En la Figura 54 vemos un grafico de redes en el que los circulos verdes representan las DMUs
eficientes y los circulos rojos las ineficientes. En este grafico puede verse como se relacionan
las DMUs ineficientes con las eficientes, que se sitian en el exterior tratando de transmitir la
idea de que forman la frontera eficiente. Ademads, podemos observar que no todos los
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circulos verdes tienen el mismo didmetro. En este caso, el tamafio del circulo pretende
transmitir la idea de la de la DMU eficiente para el conjunto de DMUs ineficientes.

Guardamos el script con el nombre: “graficos_ejemplo_12".

ST JER Plot: indice de Malquist.

Creamos una nuevo script y lo llamamos “graficos_malmquist”. Si cerramos la sesién de
trabajo: abrimos el proyecto “Paper_1", cargamos deaR y creamos el script.

Vamos a ejecutar un modelo Malmquist. Para ello, escribimos en el script:

data("EconomylLong")
data_example_15 <- read_malmquist(EconomylLong,
percol = 2,
arrangement = "vertical",
inputs = 3:4,
outputs = 5)
result_malmquist <- malmquist_index(data_example_15,
orientation = "io"

Nota: Los datos estan en formato largo.

Ejecutamos las instrucciones del script (ver Figura 55).

Figura 55. Ejecutando el indice de Malmquist.

@ RStudio File Edit Code View Plots Session Build Debug Profile Tools Window Help [ kD) = o) 24% @M Dom 25nov 14:06 Vicente Gl =
(] [ ] ~[Desktop/Paper_1 - RStudio
o - xR 2 - - Addins ~ K Paper_l — Desktop -
0| graficos_ejemplo_12.R —[7] Environment History Connections ]
Source on ST #Run | = Source = - # Import Dataset = & List ~
1 HataC"EconomyLong”) "} Global Environment =
2 data_example_15 <- read_malmquist(EconomylLong,
Data
3 percol = 2, - -
4 arrangement = "vertical”, data_ejemplo_12 List of 9
5 inputs = 3:4, data_example_15 List of 5
6 outputs = 53 EconomylLong 155 obs. of 5 variables
7 result_malmquist <- malmquist_index(data_example_15,

Hua_Bian_ 2007 3@ obs. of 6 variables

orientation = "io")
I. result_malmquist List of 14 I

resultado_ejemplo.. List of 11

Files Plots Packages Help Viewer =)
©  NewFolder = © Delete = Rename {3k More -
£ Home = Desktop = Paper_1 £
4 Name Size Modified
E .
@ RData 2.5 KB Nov 17, 2018, 1:18 PM
“ | Rhistory 10 KB Nov 25, 2018, 1:15 PM
Coll_Blasco_2006.xIsx 8.4 KB Oct 14, 2018, 2:02 PM
@ ejemplo_basic.R 844 B Nov 4, 2018, 12:04 PM
@ ejemplo_read_data.R 126 B Nov 11, 2018, 11:30 AM
@ ejemplo_read_data_fuzzy.R 0B Nov 2, 2018, 8:22 PM
1:1 (Top Level) = R Seript = @ ejemplo_read_data_malmguist.R 301B Nov 8, 2018, 5:06 PM
k i .
Console ~/Desktop/Paper_1 —_r Paper_l.Rpraj 205 B Nov 25, 2018, 1:15 PM
S e s et s e s et @ Resumen_DEA.R 668 B Nov 17, 2018, 1:17 PM
+ percol = 2, @
& arrangement = “"vertical”, Resumen_DEA_fuzzy.R 567 B Nov 19, 2018, 2:29 AM
+ inputs = 3:4, @ sesion_1.R 47 B Nov 1, 2018, 11:26 AM
+ outputs = 5) @1 sesion_2.R 1578 Nov 2, 2018, 11:28 AM
> result_malmguist <- malmquist_index(data_example_15,
+ orientation = “io") @) graficos_ejemplo_12.R 699 B Nov 25, 2018, 1:46 PM
> 9 graficos_malmquist.R 342B Nov 25, 2018, 2:00 PM

Los resultados del indice de Malmquist estan almacenados en el objeto “result_malmaquist”.
Por tanto, para obtener las graficas escribimos en el script:

plot(result_malmquist)

y ejecutamos la instruccion. En la Consola aparecerd el mensaje:
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Press [enter] to continue

Al pulsar la tecla Enter aparecera un grafico en la pestafia Viewer (parte inferior izquierda)
(ver Figura 56). Podemos hacer clic en Zoom para ver mejor el grafico. En este primer gréfico
se representan los distintos componentes del indice de Malmquist por DMU. Si hay muchas
DMUs no se vera gran cosa, pero es posible seleccionar DMUs de interés.

Figura 56. indice de Malmquist: Grafico 1.

@ RStudio File Edit Code View Plots Session Build Debug Profile Tools Window Help

B 4 = o) 21%@ Dom25nov 14:16 Vicente Q i=

e0ce ~fDesktop/Paper_1 - RStudio
o - R - ¥ + Addins -
@' graficos_ejemplo_12.R 9| graficos_malmquist.R* -0

Source on Save L S =+Run | "=+ Source -
# PASO 1. CARGAR DATOS:

Environment  History ~ Connections

P

# Import Dataset - | &

7 Global Envirenment

data( "Hua_Bian_2007") .
a

3
4
3
6 # PASO Z: ADAPTAR DATOS:
7 data_ejemplo_1Z <- read_data(Hua_Blan_zeer,
&

ni=z,
9 no=3,
18 ud_output=3)

12 # PASO 3: EJECUTAR EL MODELO DEA:
13 resultado_ejemplo_12 <- model_basic(data_ejemplo_12,

data_ejemplo_12 List of 9
J data_example_15 List of 5

J EconomyLong
) Hua_Bian_2007

D result_malmquist List of 14
) resultado_ejemplo.. List of 11

Files

Plots Packages Help { Viewer ’
P zoom | <X Export - I r'd

14 orientation="oo",

15 rts="vrs", I
16 wvtrans_o= 150@)

17

18 # PASO 4. EXTRAER LOS RESULTADOS:
19 eff <- efficiencies(resultado_ejemplo_12)

20 eff

21 1/eff # resultados M5 en tabla 6-5 (p. 119)
22

23 # RESUMEN DE RESULTADOS

24

25 summary(resultado_ejemplo_12)

26:1 | (TopLevel) R Script *

Console ~/Desktop/Pap: =0

W g = v Lieae

inputs = 3:4,

+

+ outputs = 5)

> result_malmguist <- malmquist_index(data_example_15,

i orientation = "i0")

> plot(result_malmguist)
Press [enter] to continue
Press [enter] to cumtmuﬂ

Tech. ch&igse chéngi charalm. idaff. change

155 obs. of 5 variables
3@ obs. of 6 variables

Period

£ Paper_1 — Desktop +

=0

List ~

=0

5, Publish -
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— Gansu
Guangdong
Guangxi

~ Guizhou

< = Hainan
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Heilongjiang
Henan

— Hubei

= Hunan

= Jiangsu

2009

Si volvemos a pulsar la tecla Enter (en la Consola), se crea un segundo grafico (ver Figura 57).
En esta ocasion, se representan los componentes del indice de Malmquist por periodo.
Podemos ampliar el grafico haciendo clic sobre Zoom y avanzar (o retroceder) gréficos
haciendo clic sobre las flechas. En este grafico también es posible seleccionar los
componentes del indice de Malmquist que queremos mostrar.

Figura 57. indice de Malmquist: Grafico 2.

@ RSwdio File Edit Code View Plots Session Build Debug Profile Tools Window Help G +0 = o) 20% 0 Dom25nov 14:20 Vicente Q =
ec e ~/Desktop/Paper_1 - RStudio
o - = . - Addins ~ & Paper_1 — Desktop ~
@ graficos_ejemplo_12.R 0 graficos_malmaquist.R* —["]  Environment History Connections I
SourceonSave | Q7 v +Run | o= Source + “f  Import Dataset + & List =
3 # PASO 1. CARGAR DATOS: & Global Ervironment -
4 data("Hua_Bian_z2007")
5 Data
6 % PASO Z: ADAPTAR DATOS: ¥ data_ejemplo_12 List of 9
7 data_ejemplo_12 <- read_data(Hua_Bian_2007, ) data_example_15 List of 5
: m=§’ ) Econamylong 155 obs. of 5 variables
no=3,
10 ud_output=3) Hua_Bian_2887 30 obs. of & variables
11 result_malmquist List of 14
12 # PASO 3: EJECUTAR EL MODELO DEA: resultado_ejemplo. List of 11
13 resultado_ejemplo_12 <- model_basic(data_ejemplo_12,
14 orientation="00", Files Plots Packages Help(\f wer ) =
15 rts="vrs", ) rT -
z 2 Export % Publish +
16 vtrans_o= 1508) L e T | il
17

18 # PASO 4. EXTRAER LOS RESULTADOS:
19 eff <- efficiencies(resultado_ejemplo_12)

20 eff

21 1/eff  # resultados MS en tabla 6-5 (p. 119)

2z

23 # RESUMEN DE RESULTADOS

24

25 summary(resultado_ejemplo_12)

26

27 plot(resultado_ejemplo_12)

28

17:1 (Top Level) = R Script =
Console ~/Desktop/Paper_1 =0
. Coputa = s
+ outputs = 5)
> result_malmquist <- malmguist_index(data_example_15,
+ orientation = "io")

> plot(result_malmquist)
Press [enter] to continue
Press [enter] to continue
>

value

2006 2007 2008
Period

2009

Efficiency change
Malmquist index
Productivity change
Scale change
Technical change
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Guardamos el script: “graficos_malmquist”.

dR

Il [N Plot: Eficiencia cruzada.

Creamos una nuevo script y lo llamamos “grafico_eficiencia_cruzada”. Si cerramos la sesion

de trabajo: abrimos el proyecto “Paper_1”, cargamos deaR y creamos el script.
Escribimos y ejecutamos las siguientes instrucciones (ver Figura 58):
data("Golany_Roll_1989")

data_example <- read_data(datadea = Golany_Roll_1989,
dmus=1,
inputs = 2:4,
outputs = 5:6)
result_cross <- cross_efficiency(data_example,
orientation = "io",

rts = "crs",
selfapp = TRUE)

Figura 58. Script eficiencia cruzada.

@ RStudio File Edit Code View Plots Session Build Debug Profile Tools Window Help [ 1) = o) 67%M)} Dom 25nov 19:00 Vicente QY=
L) ® ) ~/Desktop/Paper_1 - RStudic o
e - Oy - - Addins ~ % paper_1 — Desktop -

© | graficos_ejemplo_12.R @ | graficos_malmquist.R o T Environment  History Connections =0

Source on Save A - Run | *+ Source - ond ~ |mport Dataset ~ | & List v
1 [ datac Golany Rol1.1980") %% Global Environment -
2 || data_example <- read_data(datadea = Golany_Rol1_1983,
3 dmus = 1, Hata
4 inputs = 2:4, data_ejemplo 1z  List of 9
5 outputs = 5:6) data_example_15 List of 5
6 | result_cross <- cross_efficiency(data_example, EconomyLong 155 obs. of 5 variables
; ::;Ezt?::?!: A0 Hua_Bian_2007 3@ obs. of 6 variables
9 selfapp = TRUE) result_malmquist List of 14
10 Files Plots Packages Help Viewer =0
@ NewFolder | @ Delete | Rename {JF More +
#2) Home - Desktop ° Paper_1 &
A Name Size Modified
k..
@) RData 19.7 kB Nov 25, 2018, 2:20 PM
| .Rhistory 11 KB Nov 25, 2018, 2:20 PM
Coll_Blasco_2006.xIsx 8.4 KB Oct 14, 2018, 2:02 PM
@ ejemplo_basicR 844 B Nov 4, 2018, 12:04 PM
9 ejemplo_read_data.R 126 B Nov 11, 2018, 11:30 AM
9] ejemplo_read_data_fuzzy.R 0B Nov 2, 2018, 8:22 PM
@] ejemplo_read_data_malmaquist.R 3018 Nov 8, 2018, 5:06 PM
101 (Top Level) * R Script = 9@ graficos_ejemplo_12.R 6998 Nov 25, 2018, 1:46 PM
9 graficos_malmquist.R 4038 Nov 25, 2018, 2:20 PM
Sttt T == % Paper_L.Rproj 2058 Nov 25, 2018, 6:22 PM
” © Resumen_DEA.R 668 B Nov 17, 2018, 1.17 PM
© | Resumen_DEA_fuzzy.R 567 B Nov 19, 2018, 2:29 AM
9 sesion_1R 478 Nov 1, 2018, 11:26 AM
9| sesion_2.R 1578 Nov 2, 2018, 11:28 AM
I @] grafico_eficiencia_cruzada.R I 0B Nov 25, 2018, 6:51 PM
En el objeto “result_cross” se han almacenado los resultados de la eficiencia cruzada

correspondientes a los modelos: arbitrario, benevolente y agresivo. Todos estos resultados
son mostrados en forma de mapa de calor con la funcién plot(). Para ello, escribimos en el

script:

plot(result_cross)

y pulsamos la tecla Enter en la Consola para mostrar los distintos graficos. El resultado

deberia ser similar al que se muestra en la Figura 59.
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Figura 59. Graficos de eficiencia cruzada.

" RStudio File Edit Code View Plots Session Build Debug Profile Tools Window Help [ {D = o)) 65% @)} Dom 25nov 19:06 Vicente Q =
LN ) ~{Desktop/Paper_1 - RStudio
e | -3 B $ Co c - Addins - K paper_1 — Desktop -
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£ |Source on Save = O /7 - +Run | = Source - | = # [ | “# Iimport Dataset ~ | & List +
1 data("Golany_Roll_1989") 7} Global Environment =
2 data_example <- read_data(datadea = Golany_Roll_1989, Data
3 dmus = 1, - N 3
i e O data_ejemplo_12 List of 9
5 outputs = 5:6) ) data_example List of 9
6 result_cross <- cross_efficiency(data_example, 0 data_example_15 List of 5
7 orientation = "io", 3 N
8 rts = "ers”, I 3 I
3 selfapp = TRUE) sjmlany_Rull_EEQ 13 obs. of 6 variables
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Files Plots  Packages Help( Viewar> =
| ® Zoom | -2 Export - |0 Far 4 Publish -

Arbitrary Method

11:1 | (Top Level) R Script =

Console ~/Desktop/Paper_1/ ==

Sutputs = aus

> result_cross <- cross_efficiency(data_example,

+ orientation = "io",
+ rts = "crs"”,
+ selfapp = TRUE)

> plot(result_cross)
Press [enter] for next plot
Press [enter] for next plot

Ma -
A -
A -

Guardamos el script “grafico_eficiencia_cruzada”, cerramos el proyecto y salimos de
RStudio.

Esperamos que deaR te sea util y lo uses tanto en
investigacion como en docencia.

Agradeceremos cualquier comentario y sugerencia para
mejorar deaR.
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